Project: OBSERVE Table of Contents

Introduction to Observational Astronomy

A. Celestial Motion...........................6
Activity 1: Stellarium.......................16
B. Celestial Sphere..........................28
Activity 2: Choosing a Target............31
C. Telescopes: Tools of Astronomers...37
Activity 3: Filter Fun.......................45

Student Projects: Image Acquisition

Activity 4: Observation Proposal........50
Activity 5: Submit Observations.........51
Activity 6: Download Images..............54

Student Projects: Image Processing, Analysis, and Presentation

Activity 7: Reading Images..............57
Activity 8: Advanced Imaging Tools...64
Activity 9: Paper and Presentation......93
Activity 10: Web Forum...............94

Labs

Advanced Imaging.....97
Simple Color Image..98
Distance..............99
Galaxies: Classify...102
Nebulae: Classify...104
Clusters: Classify...106
Stellar Distribution..109
Galilean Satellites...112
Planetary Motion....115
Planet Hunt.........117
Size..................119
Variable Stars......122
Design Your Own...124

Additional Information

F.A.Q........................................125
Contact Information.....................127

Project: OBSERVE Handbook development was made possible by a grant from the NASA Ideas Grant Program.

Project: OBSERVE implementation during the 2007-2008 school year was made possible by a K-12 Professional Development grant from North Carolina Space Grant Consortium.

OBSERVE Project Partners

Dr. Dan Reichart  UNC-CH Department of Physics & Astronomy
Denise Young  UNC-CH Morehead Planetarium and Science Center
Dr. Michael Castelaz  Pisgah Astronomical Research Institute
Dr. Jonathan Keohane  Hampden-Sydney College

Major contributions and leadership of Project: OBSERVE provided by Jesse Richuso of UNC-CH Morehead Planetarium and Science Center. UNC-CH student Joshua Haislip developed a substantial portion of this handbook. UNC-CH students Helen Chappell, Eliot Raynor, and Jana Styblova also assisted in the development of the handbook. UNC-CH students Adam Crain, Andrew Foster, and Kevin Ivarsen developed the web interface and software for the robotic telescopes. Thanks to Elizabeth Templin of UNC-CH ISL for editing.
Foreword

Project: OBSERVE brings hands-on, high-tech astronomy into high school classrooms. During the 2007-2008 school year, Morehead Planetarium and Science Center’s Project: OBSERVE will be implemented in over 50 high school across the state. The goals of the project are to improve science literacy and provide students with an exciting hands-on way to do astronomy.

Students will become astronomers by:

- Planning an astronomical observation
- Submitting the observing proposal via the internet
- Allowing state-of-the-art robotic telescopes located in Chile to conduct the observation
- Retrieving and analyzing their data via the internet
- Writing up results
- Presenting their results to their class and posting their projects to an online forum

This teacher handbook contains three main sections. Introduction to Observational Astronomy provides background information and activities for students. Student Projects provides systematic guides on how to submit observations, download images, analyze images, and more. The Labs section provides advanced astronomical experiments for students.

Morehead Planetarium and Science Center hopes that this curriculum supplement will help students better understand observational astronomy and excite students about science.
Project: OBSERVE Classroom Implementation

Project: OBSERVE can be as intensive as the teacher chooses it to be. Two weeks dedicated to the project would be ideal for including all possible lessons and activities. However, a teacher may choose to implement only parts of the project in a shorter time span. Here is an example two-week implementation plan:

1. **Introduction to Observational Astronomy (Monday through Wednesday)**
   a. Celestial Motion + Activity 1 (Monday)
   b. Celestial Sphere + Activity 2 (Tuesday)
   c. Telescopes: The Tools of Astronomers + Activity 3 (Wednesday)

2. **Student Projects (Thursday through next Friday)**
   a. Submitting an Observation Proposal (Thursday)
   b. Submitting Observations via Skynet (Friday)
   c. Downloading Images from Skynet (Monday)
   d. Processing and Analyzing Images (Monday and Tuesday)
   e. Writing a Research Paper (Tuesday and Wednesday)
   f. Presenting Projects (Thursday)
   g. Posting Results to an Online Forum (Friday)
I. Introduction to Observational Astronomy
A. Celestial Motion

The effects of Earth’s motion through space

Even before Einstein, Newton, and Kepler, at the very beginning of scientific astronomy, people believed that there was an enormous sphere surrounding the Earth. Fixed on the sphere were thousands of tiny lights (stars), a larger light (the Moon), an extremely bright light (the Sun), and a few other wandering lights that did not seem to be fixed on the sphere (the planets). These ancient astronomers believed that this celestial sphere slowly rotated around the Earth and completed one revolution every 24 hours. Because they placed the Earth at the center of the universe, this model is described as geocentric. It is important to understand that during this time, people believed that if you could travel high enough up into the sky you would run into this celestial sphere.

In an age when rocketry and space exploration only make the news after something goes wrong, the geocentric model of how the universe works seems ridiculous. However, if one forgets all that he or she has learned in the past and simply constructs an explanation based on observations, the geocentric model is quite logical. Everything in the night sky, except airplanes and UFOs, seems to rise in the east and set in the west. Without having the ability to reach the sky with airplanes, balloons, or rockets the people who believed in the geocentric model did not think the sky had depth. Without the concept of depth, a solid celestial sphere rotating around the Earth almost perfectly describes the observations.

We now know that there is no celestial ceiling above, closing us in and trapping us to the confines of the Earth’s surface. Instead, we have found that the size of the universe is so great that no human mind can fully grasp its magnitude. By looking at the situation from a different perspective, a new explanation of why the stars seem to move across the sky has been developed and proven. The Earth makes one complete rotation in 24 hours. Our view of the sky changes as the Earth spins around.

The effects of Earth’s rotation

An analogy helps to explain the relationship between Earth’s rotation and the motion of the sky. Nearly everyone has ridden, seen, or heard about a merry-go-round. Once the passengers sit down, the ride begins to spin. There are two two different points of view from which we can analyze this situation:

Thoughts of a mother after a ride on the merry-go-round with her child:

“I placed my baby up on a horse. She looked a little scared but did not start to cry. I heard the whining of the motors as they strained to start the carousel spinning. My baby looked a little confused, but she began to smile. I am always amazed at how the machine is able to make the floor, the horses, and everything else on the ride spin around so gracefully.”

Thoughts of an infant after a ride on the merry-go-round:

“That was really weird. I was nervous and excited at the same time as I waited for the ride to start. Then, suddenly, I felt a slight jerk and when I looked up I saw the entire world start to spin
around. My dad, who decided not to ride, was standing on the other side of a fence. He looked like he was standing still, but he was not. His legs were not moving, yet he still was moving in circles around me. It was as if the ground beneath his feet were moving him and everything else around me. I thought about how powerful this machine must be in order to spin everything around like it did.”

While infants probably do not think this during the ride, it does serve as a good analogy. The infant could not really feel herself spinning around because the carousel did not spin very quickly. Based on what she observed, she concluded that the trees, ground, sky, and even her father were being spun around her. This is exactly how, many years ago, astronomers tried to explain why the sky moved above them.

To understand the effect of the Earth’s rotation, see Figure 1.1. Each slide depicts the Earth, as viewed from above the North Pole, at a different time during the day. The arrows point toward what people in North Carolina would see should they look at the sky directly overhead. Notice how their view of the sky changes over the course of the day. More importantly, note that the rotation is the reason we have day and night.

After closely analyzing these images, one would realize that something is very strange. The North Pole remains in the sunlight throughout the entire day. These figures represent a day in June, which is summer in the northern hemisphere. From the figures, one can conclude that during the summer the Sun never sets at the North Pole.
In fact, during this time of year, if one travels north from the Equator the daily period of daylight would continually grow longer until it remained light for the entire 24 hours. The exact opposite would happen if one travels south from the Equator. The period of daylight would continually grow shorter until it was dark for all 24 hours of the day.

These observations also demonstrate the effects of another characteristic of Earth’s motion: its \textit{tilt}. The axis about which the Earth rotates is tilted 23.5 degrees with respect to the Sun. In the months of June, July, August, and September, the northern hemisphere tilts toward the Sun. This causes the Sun to be higher in the sky and the Sun’s rays of light to strike the northern hemisphere more directly. As a result, the days are longer and warmer (it is summer). During the same months, the southern hemisphere tilts away from the Sun. This causes the Sun to stay lower in the sky and its rays of light to be less direct; therefore, the days are shorter and colder (it is winter).

\textbf{The effects of Earth’s revolution}  
If rotation and tilt were the only two characteristics of Earth’s motion, then seasons would never change. However, the seasons follow a cycle slowly progressing from summer to fall to winter to spring and then back to summer. The third major characteristic of Earth’s motion is its \textit{revolution}. Every
365.25 days, the Earth makes one complete revolution around the Sun. Since we use a solar calendar, our year is based on the Earth's revolution around the Sun. In fact, the reason we have leap years is to correct the fact that Earth's revolution does not last a perfect 365 days. If we were to use our 365-day calendar without correcting it, we would be approximately a full day off every 4 years. While this does not seem like a lot, in 120 years our calendar would be an entire month off. Such inaccuracies would cause great confusion across the world.

Due to Earth's revolution, during the months of December, January, February, and March the Earth is on the opposite side of the Sun. While the tilt remains the same, the situation with the hemispheres is now reversed. The southern hemisphere is tilted toward the Sun and the northern hemisphere is tilted away from the Sun. As a result, the southern hemisphere experiences summer and the northern hemisphere experiences winter.

Proving that the Earth is moving around the Sun is much simpler than most people think, all that is required is a piece of paper and a pencil. Simply go outside during the summer and draw patterns of stars that you can easily recognize. Wait six months, then go back to the same location outside, and see if you can find the patterns of stars you drew in the summer. Due to Earth’s motion around the Sun, you will not find them. The visibility of stars changes over the course of the year (see Figure 1.2).
Notice in Figure 1.2 that the constellation Orion is visible on a night in January. However, in June the Earth will be on the other side of the Sun. This means that the Sun will be in between the Earth and the stars that make up Orion. In other words, during this part of the year the Orion constellation is up in the sky during the day. Due to the overwhelming brightness of the daytime sky, we cannot see stars during the day and, therefore, the Orion constellation is not visible. Since Orion is visible in January (winter in the northern hemisphere), we call it a winter constellation. One must be careful when classifying the constellations by seasons since winter in the northern hemisphere occurs during summer in the southern hemisphere. This means that while Orion is considered a wintertime constellation north of the Equator, it is considered a summertime constellation south of the Equator.

This change in the view from Earth of the stars in the night sky is visible on a day-by-day basis. To observe the change note the time when a star rises above the horizon. Each night, stars rise about four minutes earlier than the previous night. Table 1.1 consists of rising and setting times for the star Betelgeuse (pronounced: Beetle-juice):

<table>
<thead>
<tr>
<th>Day</th>
<th>Rise</th>
<th>Set</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5:00 PM</td>
<td>5:51 AM</td>
</tr>
<tr>
<td>2</td>
<td>4:56 PM</td>
<td>5:47 AM</td>
</tr>
<tr>
<td>3</td>
<td>4:52 PM</td>
<td>5:43 AM</td>
</tr>
<tr>
<td>4</td>
<td>4:48 PM</td>
<td>5:39 AM</td>
</tr>
<tr>
<td>5</td>
<td>4:44 PM</td>
<td>5:35 AM</td>
</tr>
<tr>
<td>6</td>
<td>4:40 PM</td>
<td>5:31 AM</td>
</tr>
<tr>
<td>7</td>
<td>4:36 PM</td>
<td>5:27 AM</td>
</tr>
<tr>
<td>8</td>
<td>4:32 PM</td>
<td>5:23 AM</td>
</tr>
<tr>
<td>9</td>
<td>4:28 PM</td>
<td>5:19 AM</td>
</tr>
<tr>
<td>10</td>
<td>4:24 PM</td>
<td>5:15 AM</td>
</tr>
<tr>
<td>11</td>
<td>4:20 PM</td>
<td>5:11 AM</td>
</tr>
<tr>
<td>12</td>
<td>4:16 PM</td>
<td>5:07 AM</td>
</tr>
<tr>
<td>13</td>
<td>4:12 PM</td>
<td>5:03 AM</td>
</tr>
<tr>
<td>14</td>
<td>4:08 PM</td>
<td>4:59 AM</td>
</tr>
<tr>
<td>15</td>
<td>4:04 PM</td>
<td>4:55 AM</td>
</tr>
<tr>
<td>16</td>
<td>4:00 PM</td>
<td>4:51 AM</td>
</tr>
</tbody>
</table>

Table 1.1

Betelgeuse is the bright red star that represents an armpit of Orion the hunter. An even more transparent way of observing the change in the rising and setting times of a star is to look at the transit times of the same star on the first day of each month throughout the entire year (see Table 1.2). The transit time of a star is the moment when the star reaches its highest point in the sky. After a star transits, it begins to sink back down toward the western horizon. The small difference of four minutes each night makes a big difference over the course of the year. On average, Betelgeuse transits about two hours earlier each month.

Project: OBSERVE 2007
<table>
<thead>
<tr>
<th>Month</th>
<th>Transit</th>
<th>Visibility</th>
</tr>
</thead>
<tbody>
<tr>
<td>January</td>
<td>11:23 PM</td>
<td>visible</td>
</tr>
<tr>
<td>February</td>
<td>9:21 PM</td>
<td>visible</td>
</tr>
<tr>
<td>March</td>
<td>7:31 PM</td>
<td>visible</td>
</tr>
<tr>
<td>April</td>
<td>5:29 PM</td>
<td>not visible</td>
</tr>
<tr>
<td>May</td>
<td>4:32 PM</td>
<td>not visible</td>
</tr>
<tr>
<td>June</td>
<td>2:30 PM</td>
<td>not visible</td>
</tr>
<tr>
<td>July</td>
<td>12:32 PM</td>
<td>not visible</td>
</tr>
<tr>
<td>August</td>
<td>10:30 AM</td>
<td>not visible</td>
</tr>
<tr>
<td>September</td>
<td>8:28 AM</td>
<td>not visible</td>
</tr>
<tr>
<td>October</td>
<td>6:30 AM</td>
<td>visible</td>
</tr>
<tr>
<td>November</td>
<td>3:28 AM</td>
<td>visible</td>
</tr>
<tr>
<td>December</td>
<td>1:30 AM</td>
<td>visible</td>
</tr>
</tbody>
</table>

Table 1.2

Table 1.2 also shows that by looking at the transit time, one can determine if the star is up during the day or the night. The Visibility column notes whether the star is in the sky during the day or the night. Betelgeuse is only visible during the winter months. This makes perfect sense because we know Betelgeuse is part of the Orion constellation, and, as previously noted, Orion is a winter-time constellation in the northern hemisphere and is only visible in the winter months.

**How does the sky look from different locations on Earth?**

Not only does the time of year determine which celestial objects are visible from Earth and which are not, but our location on the Earth also plays a significant role. Let us analyze how the sky would change as we travel around the world. We will begin our trip at the airport in Raleigh, NC where we depart just before the Sun sets at 8:15 PM EDT. Flying in a fighter jet and traveling at a speed of 794 miles per hour, we will depart for our first destination: San Francisco, CA. At this speed, the trip should take about 3 hours resulting in an arrival time of 11:15 EDT.

By flying at 794 miles per hour toward the west, we are "chasing" the Sun as it sets. In fact, the rate at which we are chasing the Sun is the same as the rate at which the Sun appears to be moving west in the sky. By matching these rates, the Sun no longer appeared to move at all. It simply stayed in the same place in the sky. Upon landing in San Francisco, you could exit the aircraft, go outside and enjoy the rest of the sunset that began three hours earlier while you were in North Carolina. This would truly be the longest sunset of your life.

After the Sun goes down, you would look up into the sky and see the same constellations and stars that were visible from North Carolina. The only difference is the time you can see them. For example, the Sun set in Raleigh, NC around 8:15 PM EDT, but did not set in San Francisco,
CA until 11:15 PM EDT. If you saw the constellation Leo the Lion just after sunset in North Carolina at 9:00 EDT, you would not be able to see this constellation in San Francisco, CA until 12:00 AM EDT.

From this trip, we learn that as long as we are traveling due east or due west, the celestial objects that are visible to us do not change. The only thing that changes is the time when we are able to see them.

Now we need to analyze what happens to the sky as we travel north or south. Let us start back in Raleigh, NC and leave just after sunset. Before boarding the plane, we look toward the north at the night sky, take out a piece of paper, and make a sketch of the constellations that are visible.

We then turn around and look at the southern nighttime sky, take out another piece of paper, and make another sketch.

Now we can board the jet, take off, and head due south. After flying for a little over an hour, you start to feel hungry. To grab some food, you decide to take a pit stop and land in Miami, Florida. Once you are on the ground, you take out two more sheets of paper and make another sketch of the northern and southern sky.

---

Figure 1.3: North Carolina  
Figure 1.4: Florida
Let us look at the difference between your sketch of the northern sky in North Carolina (Figure 1.3) and the sketch you made of the northern sky from Florida (Figure 1.4). In the view from North Carolina notice how far the constellations Cassiopeia and Cepheus are from the horizon. Now compare that to how far they are from the horizon in the view from Florida. Cassiopeia has dropped completely below the horizon, and you can no longer see all of Cepheus. What could cause this to happen?

We could come up with one explanation based on our understanding of the Earth’s rotation. We know that this motion causes the Sun, Moon, and stars to appear to rise and set. Therefore, one might say that during our hour-long flight, the constellation of Cassiopeia set and is now below the horizon. While this is an excellent use of our previously gained knowledge, it is incorrect. To understand this, let us examine that exact path that the constellation Cassiopeia would have followed if we had never left North Carolina.

Before the age of maps, satellites, and Global Positioning Systems (GPS), sailors navigated the oceans using the stars. One star, called Polaris (or the North Star), was very important to them. Sailors knew that over the course of a night, all stars in the sky seemed to follow a circular path around this star. They also knew that by measuring how far this star was above the horizon, they could determine their latitude (how far north or south they were on the Earth).

We will use your sketch from North Carolina to determine the path of Cassiopeia and our latitude.

The first step is to find Polaris, the North Star. Many people have seen the big dipper and can recognize it in the sky. If you can find the big dipper, you can easily find the North Star. Simply
connect the two stars that are opposite from the handle with a line (these stars are denoted by the (1) and (2) in the Figure 1.5 above). Now extend this line out as shown above. The first bright star you reach is Polaris (denoted by the dark circle in the Figure 1.5).

Now that you have found the North Star, we can determine our latitude as well as the motion of Cassiopeia. To determine the latitude, sailors would use an instrument called a sexton to measure the angle shown in the Figure 1.6. For North Carolina, the North Star is about 36 degrees above the horizon. This means that North Carolina has a latitude of approximately 36 degrees!

All that is left for us to do now is to determine the path of Cassiopeia. Let’s draw several circles of different sizes centered on the North Star (Figure 1.7). From this, we can see that Cassiopeia comes very close to the horizon, but it does not ever fully go below the horizon in North Carolina. Constellations that never seem to set or rise are called **circumpolar**.

Had we waited in North Carolina for about an hour and sketched the sky again, we would have seen stars like those in Figure 1.8. Notice how the constellations followed the circles, which we drew in Figure 1.7.
Now we can return to the main reason for this exercise. Glance back at Figure 1.3 and Figure 1.4 to refresh your memory on how the views from North Carolina and Florida differed. Remember that Cassiopeia sank below the horizon. Since we now know that the usual motion of the sky did not cause Cassiopeia to set, we can determine that our motion across the Earth must have caused this change. As we travel south, celestial objects in our northern sky begin to sink closer to the horizon. Those that are already close to the horizon can actually sink below.

It turns out that the exact opposite occurs with the southern sky. As you fly south, celestial objects in the southern sky seem to rise up above the horizon. Figures 1.9 and 1.10 demonstrate this:

![Figure 1.9: North Carolina](image1)

![Figure 1.10: Florida](image2)

Notice how new constellations rise up from the southern sky. For example, the constellation Centaurus and the Southern Cross (depicted in Figure 1.10 to the left of the “S”) are now visible in Florida!

From this trip, we learned two valuable lessons:

1. When traveling east or west, the objects that are visible to the observer do not change. However, the times when they are visible do change.

2. When traveling north or south, the sky is truly different. The objects that are visible change depending on how far north or south you are on the Earth.

To try this out for yourself, see Activity 1 entitled “A Virtual Tour of the Night Sky with Stellarium.”
Activity 1: A virtual tour of the night sky with Stellarium

Stellarium is free software available on the internet. It allows you to see the night sky as it would look at any time and from any place around the world. It is an excellent way to find your way around the night sky and can also be used to choose celestial targets that are visible to your telescope.

The first step in using Stellarium is opening it. Double click the Stellarium icon on your desktop.

Now, here are some of the things you can do with Stellarium:

Introduction to Stellarium:

Upon opening Stellarium, you will probably see a screen similar to the image shown below:

The figure above depicts Stellarium during the daytime. It is for this reason that you do not see any stars. Depending on the time of day to which Stellarium is set, it may appear to be nighttime on your screen. There is nothing wrong with this. Simply continue through the steps below.

1. Move your mouse toward the center of the image.
2. Click and Drag your mouse around to see what effect it has in Stellarium.

As you drag your mouse in Stellarium, your point-of-view changes, allowing you to see in more than one direction. Try this click and drag method to look in all directions.
Now find the **Page Up** key on your keyboard. Press the page up key to see what affect it has in Stellarium. Now try the **Page Down** key. You should notice that these keys allow you to zoom in and out on the sky. Zooming in and out will prove to be very useful later in this activity.

**Controlling Time:**

When you open Stellarium, it automatically opens in the current time. To check this, simply look in the upper-left corner of the screen. You should see the following:

![Date and Time](image)

This box will tell you the date and time to which Stellarium is currently set. You will probably notice that the time is moving forward at the normal rate. Imagine that you want to see the sky as it would look two hours in the future. At this rate, you would have to wait two hours! For Stellarium to be useful, we need to be able to speed up time.

1. Look in the bottom right corner of your screen to find the time controls:

![Time Controls](image)

2. Click on the **double forward arrows** (c.) to speed up time. The more times you click the double forward arrows, the faster time will progress.

3. To slow down the time, simply click on the **double backward arrows** (a.). The more times you click on these arrows, the slower time will progress. In fact, if you click the double backward arrows enough, time will actually come to a stop. Once this occurs, clicking the double backward arrows will begin to reverse time. Just like in step number two, the more times you click the button, the faster time will progress, only in this case time will move into the past.

4. After changing the rate that time passes both into the future and into the past, you may find it hard to figure out what the correct rate of time is. There is a simple way to switch back to real time. Simply click the **play button** (b.).

Even though time is now progressing at the correct speed, you will probably no longer be at the current time. In fact, you may be months, or even years, into the future. To return to the current time, click the **Now button** (d.)

While this is an excellent way of moving forward or backward in time by a couple of hours, imagine how long it would take to progress months, or even years. To quickly move to a
certain date and time, we can use a different tool. Look in the bottom left corner of the screen to find the menu bar:

Click on the wrench button (m.) to bring up the following configuration window:

Now click on the Date & Time tab, which is highlighted in red in the figure above.

You will then be able to adjust the year, month, day, hour, minute, and second by clicking the up and down arrows (highlighted in red in the figure below):
When you are done, you can close the configuration window by clicking the box in the upper right corner of the window. Remember, you can always switch back to the current time and date by clicking the **Now** button in the time control bar.

**Changing Location:**

Not only is it possible to use Stellarium to see the sky as it would look at anytime, but Stellarium also allows us to see the sky as it would look from any place.

1. Once again, return to the configuration window by clicking the **wrench** button in the menu bar. Clicking on the **location tab** should open the following map:
2. In the map shown above, a yellow dot is shown over the eastern coast of the United States. This means that Stellarium is showing us the skies as they would be seen from the eastern coast of the United States. To change the location, simply move your mouse over the map and click in a new location. The yellow dot should move to the new location you selected. Do not click the Save Location button. Stellarium has been set to always open showing the skies from North Carolina. Clicking the save location button will change this default location. You may notice that as you click various places on the world map, the scene depicted behind the configuration window will change. You can move around the world without saving your location, so there is no need to click the Save Location button. Clicking the map will immediately change your current location.

3. Another way to change the location is to use the Latitude and Longitude. By clicking the up and down arrows, you can change a location’s coordinates. For example, the coordinates of Chapel Hill, NC are 35.91 and -79.0566. Which of these numbers is the latitude and which is the longitude? Try both and watch the yellow dot! In the blank below each set of coordinates, type the name of the continent where you expect to find the yellow dot.

Hints:

1. You may not be able to reach the exact numbers written below using the up and down arrows (using numbers that are as close to the actual coordinates as possible will suffice).
2. There is no need to click the arrows thousands of times. Remember that you can always click on the map and watch the longitude and latitude change. Click around until you get close
to the coordinates listed below and then use the arrows to ‘fine tune’ your coordinates.

Longitude: -79.0566  Latitude: 35.91  
Longitude: 35.91  Latitude: -79.0566

Circle the pair of coordinates for Chapel Hill, NC. Choosing the wrong coordinates would take us to a part of the world that has freezing temperatures year round, months without seeing the sun, and pesky penguins.

4. After selecting a new location, close the map by clicking the box in the upper right corner of the configuration window.

Exploring the Night Sky:

Using the skills you learned above, open the configuration window. Set the location to somewhere in North Carolina (you need not be precise, clicking on the map near North Carolina will be sufficient). Also set the date to the current date and the time to 11:00 PM. Close the configuration window.

No matter what time of year, it is always dark by 11:00 PM in North Carolina. For this reason, Stellarium should now have the sun below the horizon and it should appear to be dark. Let us explore the rest of the buttons on the menus bar:

a. Drawing the Constellations
   This is the On/Off button for the constellation figures. When turned on, you will see lines in the sky that connect stars forming constellation figures. These figures are very simple and are constructed only from lines. This is the best tool you can use to visualize the constellations. Use the lines to gain a general idea of the constellation’s shape and size. Then use your imagination to fill in the blanks.

b. Names of the Constellations
   When trying to visualize constellations, it helps to know their names. This is the On/Off button for the constellation names. When turned on, you will see the names of the constellations written in the sky.

c. Constellations Art
   The On/Off button for constellation art will help those who find it difficult to imagine the constellations. When turned on, you will see an artist’s interpretation of the constellations. Because different cultures viewed the sky in different ways, it is
important to remember that this is only one interpretation of the sky. In the future, Stellarium hopes to make many different cultures’ views of the night sky available in the constellation art.

d. Azimuthally Grid
If you remember from the “Celestial Sphere” section, there are two main coordinate systems that astronomers use. The most common system is right ascension and declination. The other is called the Altitude-Azimuth system. Astronomers rarely use this system because it is fixed to the earth. You can easily see that this is the case by turning on the azimuthal grid. After clicking this button, you should see curved lines in the sky. Now speed time up enough so that you begin to see the stars move across the sky. Notice that the coordinate system (curved lines in the sky) does not move with the stars. This means that using this system over the course of a night, the coordinates of all of the celestial objects will change! In fact, the coordinates of the celestial objects would also be different depending on where on the Earth you were viewing them. It is for these reasons that this system is rarely used.

e. Equatorial Grid
This is the On/Off button for the most commonly used coordinate system in astronomy. Clicking the equatorial grid button will bring up another set of curved lines called lines of right ascension and lines of declination. They are similar to the lines of longitude and latitude on Earth. Unlike the Altitude-Azimuth system, these lines are fixed to the sky. To see this, simply increase the rate that time passes until you can see the stars appear to move across the sky. Notice how these lines move with the stars. This means that the coordinates of a celestial object will not change over the course of a night. It also means that they will not change as you travel around the Earth, observing from different locations. It is for these reasons that this system is nearly always used in astronomy.

f. Ground
This is the On/Off button for the depiction of the ground. Since Stellarium is a virtual planetarium, the ground serves only as a reference for you. Without it, you can see the entire celestial sphere. In a way, removing the ground is kind of like placing yourself out in space. The earth is no longer blocking your view. Try removing the ground when it is night-time. You will then be able to view all 360 degrees of the sky. You may also notice that the Sun is visible. Remember that this is not realistic because you would never see the stars that are around the Sun because the Sun’s brightness overpowers them. Also, the atmosphere turns a bright blue color making the stars less visible.

Note: If you remove the ground during the daytime, you may notice two suns! This is a problem in Stellarium that should be fixed in upcoming versions. It is best to only remove the ground during the nighttime.

g. Cardinal Points
This is the On/Off button for the cardinal points. When turned on, the cardinal points button will label the horizon with letters that represent the directions North, South, East, and West.
h. Atmosphere

The atmosphere is the reason the sky is blue during the day and reddish-orange during sunsets and sunrises. In fact, the atmosphere really causes the daytime and nighttime effect. Out in space, there is no blue sky. Therefore, stars are visible at all times. The atmosphere button is the On/Off button for the simulated atmosphere. See what happens when you remove the atmosphere during the daytime. Also, see what effect it has when you remove the atmosphere during the night.

i. Nebulas

This is one of the most useful tools in Stellarium. It is the On/Off button for labels of galaxies, nebulas, and star clusters in the sky. When turned on, you will see labeled blinking yellow dots in the sky. Most of these labels will begin with the letter M and be followed by a number. The M is used because these celestial smudges are called Messier Objects after Charles Messier (pronounced “Messy A”). Around the end of the 18th century, this French born astronomer began to catalogue objects in the sky that did not appear to be stars. While he did not know this at the time, these fuzzy objects were galaxies, nebulas, and star clusters. As a result of his detailed work, they became known as Messier objects.

Having a button called Nebulas in Stellarium is somewhat misleading. Instead, it should be called Messier Objects. Always remember that the yellow flashing dots represent more than just nebulas. In fact, most of the dots are star clusters.

j. Equatorial/Altazimuthal Mount

This button changes the way the sky moves when you click and drag across the screen. The name of this button stems from the names of the two main coordinate systems used by astronomers. In fact, to cope with both coordinate systems, the mount upon which a telescope rests can be made to move in two completely different manners. One of these, the altazimuthal mount, moves either perpendicular or parallel to the horizon. This means that such a telescope would follow the Altitude-Azimuth lines that appear after pressing button d. The second type is the equatorial mount. A telescope on this type of mount would follow the lines of right ascension and declination. These lines appear after pressing button e.

Try both of these mounts to see which you prefer and feel free to use either.

k. Goto selected object

You must first click on an object in the sky to see what this button does. Make sure it is nighttime and that the Nebulas button is turned on. Attempt to locate a Messier object in the sky and then click on it. A box should appear around your object. Now click on the Goto selected object button to see what it does. Stellarium should move the sky so that the object you selected is in the center of the screen. What do you think your Messier Object is? Is it a nebula, star cluster, or galaxy? Hint: Do you remember how to zoom in and out?
I. Search for Object

This button will bring up a new window titled **Object Search**. The Object Search will allow you to find objects if you know their name. Within the Object Search window, you will see four tabs: Stars, Constellations, Nebula, and Planets & Moons. Choose the tab that corresponds to the type of object you wish to find, then type in the object’s name and press the Enter or Return key on your keyboard. Stellarium will position the sky so that your object is in the center of your screen. To close the screen, simply click the small box in the upper right corner of the Object Search window.

![Object Search Window](image)

**Note:** If you do not see anything on your screen after pressing enter, the object is most likely below the horizon. In this case, you are looking directly down at the ground. An easy way to avoid this is to remove the ground with button f.

m. Configuration Window

We are already familiar with this button from the first part of this activity. Clicking this button will bring up a window for configuration. The only two tabs that you should be concerned about are the Location and Date & Time tabs. Both of these were discussed earlier in this activity.

n. Help

This button brings up a window called Help (see figure below). It contains a list of all of the shortcut keys. In other words, it explains what the keys on your keyboard do. For example, you may notice that beside Page Up/Down it has the word Zoom. As we already know, the page up and page down keys on the keyboard allow us to zoom in and out on the sky.
0. Quit

Clicking this button will exit Stellarium.

Object Information:

In this section, you will learn how easy it is to extract information about a celestial object in Stellarium.

1. Make sure the time and location are set so that it is night.
2. Zoom out so that you can see a large portion of the sky.
3. Click on a star (not a Messier Object)

Notice the circle that appears around your object as well as the information box that appears in the upper left corner:
Here is the meaning behind the information given:

**Name:** This is simply the full name of the object.

**RA:** This stands for Right Ascension and is one of the object’s coordinates; similar to longitude on Earth.

**DE:** This stands for Declination and is one of the object’s coordinates similar to the latitude on Earth.

**Magnitude:** This is a measure of how bright the object is. To give you an idea of this brightness scale, here are some very well-known examples:

<table>
<thead>
<tr>
<th>Object Name</th>
<th>Magnitude</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sun</td>
<td>-26</td>
</tr>
<tr>
<td>Full Moon</td>
<td>-12</td>
</tr>
<tr>
<td>Sirius (brightest star in the sky other than the sun)</td>
<td>-1.5</td>
</tr>
<tr>
<td>Jupiter</td>
<td>-2.0</td>
</tr>
<tr>
<td>Pluto</td>
<td>14.78</td>
</tr>
</tbody>
</table>

Notice that the brightest objects have the lowest numbers.

**Distance:** This number tells you how far away the object is from the Earth. The unit for measuring distance is the Light Year. **Note:** Even though the word *year* appears here, always remember that a light year is a measurement of distance and not time. The reason for its confusing name is that one light year is the distance light could travel in one year. What is truly amazing is that one light year is equivalent to about six trillion miles.

**Hip:** You can think of this number as the star’s social security number. It is an identification number that was given to the star when the Hippocras satellite measured its brightness.
Stellarium Challenge

Introduction: Use Stellarium to answer the questions below.

1. I am located at a declination of 90°. A long time ago, sailors used me to guide their ships at night.
   Who Am I? ___________

2. I am the brightest star in the western sky during late summer nights in North Carolina. You can also find me by following the path of the big dipper’s handle.
   Who Am I? ___________

3. I am the brightest object directly overhead on May 6, 2006 at 8:30 PM in Chile.
   Who Am I? ___________

4. I am a triangular shaped constellation that is easily seen from Chile.
   Who Am I? ___________

5. The luxury liner Titanic sunk on the night of April 14, 1912 at 11:40 PM. Robert Ballard found her wreck in 1985 at the coordinates:

   Latitude = 41.73
   Longitude = -49.95

   What was the night sky like from this location in 1912? Was the moon in the sky? If not, where was the moon? What time does it rise? What was the phase of the moon? Your answer may help explain why the ship’s crew did not see the iceberg. In addition, it might explain why finding survivors was extremely difficult.

6. Chinese and Arab astronomers recorded a new star in the night sky in 1054 AD. It grew brighter each night for weeks and was even visible during the daytime. It took months for the star to fade away and disappear from the sky. Astronomer’s now know that they witnessed the death of a massive star. It died in an extremely bright explosion called a supernova. The following are coordinates of where this new star appeared back in 1054:

   RA: 5:34:30   DEC: 22:01:00

   Is there anything at these coordinates today? If so, what is it? How might it relate to the supernova?
B. Celestial Sphere

In Celestial Motion, we learned that simply choosing a celestial object to observe does not guarantee that it will be visible through telescopes. Factors such as the observer’s location on the Earth and the time of year play a role in determining an object’s visibility.

There are two main types of observational targets in the sky: those that are within the solar system (such as planets, asteroids, and comets) and those that are outside the solar system (such as nebulae, stars, galaxies, and globular clusters). The procedure for locating objects in the sky slightly differs depending on the type of object. Before discussing the difference in the procedure, let us begin by learning about the astronomical coordinate system.

In attempting to understand a celestial coordinate system, it is best to refer back to the more commonly known Earth-based system: longitude and latitude (see Figure 2.1).

Latitude measures how far north or south something is located on Earth. Longitude measures how far east or west something is located on Earth.

Instead of placing this coordinate system on the earth, pretend there is an enormous black sphere surrounding the earth. Attached to this sphere are the stars, moon, planets, comets, asteroids, and everything else you see in the night sky. Place lines on this sphere that are very similar to those shown above, but instead of calling them latitude lines and longitude lines, call them declination lines and right ascension lines, respectively. The declination lines, measured in degrees, indicate how far north or south a celestial object is located on the sphere. This is very similar to the lines of latitude on the Earth. Here is an example of such a coordinate for the Orion Nebula:

| Orion Nebula | Declination: -05 23’ 27.9” or 5:23:27.9 |

The declination of the Orion Nebula is -5 degrees, 23 arc minutes, and 27.9 arc seconds. As you will see later, for determining whether this object is visible from a certain location, you only...
need to pay attention to the first number, in this case -5 degrees. Always remember that lines of declination are measured in degrees!

The right ascension line indicates how far east or west a celestial object is located on the sphere and is very similar to the lines of longitude on the Earth. Here is an example of such a coordinate for the Orion Nebula:

<table>
<thead>
<tr>
<th>Orion Nebula</th>
<th>Right Ascension: 5:35:17.3</th>
</tr>
</thead>
</table>

The right ascension of the Orion Nebula is 5 hours, 35 minutes, and 17.3 seconds. Once again, for the purposes of determining whether an object is visible from a certain location, you only need to pay attention to the first number, in this case 5 hours. Always remember that lines of right ascension are measured in hours!

Locating fixed objects on the celestial sphere

Through our understanding of the motion of the Earth, we know that its spin makes the sky appear to rotate around the Earth. As the Earth rotates our view of the celestial sphere changes. To observers on the Earth, celestial objects rise in the east and set in the west. Since the coordinate system (right ascension and declination) is fixed to this moving sphere, it too moves across the sky.

For example, if you were to point a telescope at the coordinates for the Orion Nebula, the nebula (and therefore its coordinates) would slowly move out of the field of view. Soon you would be looking at a completely new set of coordinates, simply by leaving the telescope pointing at a stationary position in the sky. Astronomers use telescopes that stay on the same set of coordinates, tracking across the sky with the object.

Since the coordinates of objects outside of the solar system do not change over time, catalogs of objects and their coordinates can be published in books. Astronomers use the books to lookup the coordinates of the object they want to observe.

To learn which objects and coordinates are observable from the PROMPT telescopes in Chile, complete Activity 2, “Choosing your Observation Target.”

Objects in our solar system, such as planets, do not have fixed coordinates. The explanation for this can be found in the very meaning of the word “planet.” In Latin, it means, “to wander.” For thousands of years, many different cultures kept records of what they saw in the night sky. Some astronomers, at the very beginning of scientific astronomy, believed that there was an actually enormous sphere surrounding the Earth. Fixed on the sphere were thousands of tiny lights (stars). There are also things that moved on the sphere: a bright light (the Moon), an extremely bright light (the Sun), and a few other wandering lights that did not seem to be fixed on the sphere (the planets). As the planets move around the sun, they seem to wander around on the celestial sphere through the stars.

This may make you wonder how one would find a planet’s coordinates if it is moving around on the sphere. In other words, how would one find the latitude and longitude of a car as it drives across the United States?
The answer is that it is impossible to find a single pair of coordinates (right ascension and declination) for a planet because the coordinates of planets are constantly changing. Instead, you must continuously update a planet’s coordinates as it moves across the celestial sphere.

We can measure the motion of solar system objects by comparing their positions to stars over time. Stars, being fixed on the celestial sphere, act as a background.

This process of tracking an object’s motion by making comparisons to the background stars is even used by astronomers to discover asteroids, comets, planets, and any other object that moves through the solar system. By carefully observing and creating diagrams of such objects over the course of a night, month, or sometimes even years, one would see an object move across the background stars in their images. Using this method, it is possible to not only find new objects but also to determine details about their orbit and movement around the Sun. Some asteroid and comet hunters use this data to determine whether the object intersects with Earth’s orbit and if the object poses a threat to Earth.

While this tracking method is extremely useful for finding solar system, an important detail cannot be left out. The Earth is also orbiting around the Sun! The movement of the Earth around the Sun also contributes to the changing position of solar system relative to the background stars.

To understand why, put your index finger directly in front of your face. It represents a planet. Your eyes represent the Earth at different spots along its orbit. Alternate closing your left and right eyes (If this is difficult for you, use your other hand to cover your eyes). As you blink back and forth, you get two different views of your finger – one from the right eye’s perspective and one from the left eye’s perspective. Your finger seems to jump back and forth compared to whatever is in the room. In the same fashion, the Earth gets different views of a planet as it moves around the Sun, and its location relative to the background stars changes.

The motion of a planet against the background stars is due to not only the planet’s own motion around the Sun, but also the motion of the Earth.

*To learn how to find the current, updated coordinates of an object within the solar system, complete Activity 2.*
Activity 2: Choosing an observation target

As we learned in the previous lesson, the procedure for finding objects in the sky depends on whether or not the object is located within the solar system. For this reason, this activity is broken into two parts:

a. Choosing targets outside of the solar system (nebulae, galaxies, stars, globular clusters, etc.)
b. Choosing targets within the solar system (planets, asteroids, comets, etc.)

First, determine what type of target you want to observe and then skip down to the appropriate section.

a. Choosing targets outside of the solar system

Now that you understand that the RA-Dec coordinate system is used to locate objects in the night sky, we must explore what objects/coordinates are visible to in Chile, South America.

Remember that coordinates for these objects do not change much over time. For this reason, a database with your target’s coordinates will be made available to you when you submit your observation. For now, however, you will be given the coordinates of several objects and asked to determine whether they are visible or not.

PROMPT can only take images of objects that get high enough in the sky at some point during the night that you request to observe them. As mentioned in the background section, there are two main reasons that an object is not observable by PROMPT:

1) **The object is too far north on the celestial sphere.** Any object with a declination of greater than about 30 degrees north cannot be observed by PROMPT (see figure 2.2) For example, you could never take images of any celestial objects in the Big Dipper, because the Big Dipper is too far north.

2) **The object does not get high enough in the night sky.** This may be because the object is currently too close to the Sun (up in the daytime sky). In addition, the object may be close to Prompt’s upper range of Northern declinations. PROMPT can only take images of objects that are about 15 degrees above the horizon.

You can figure out if an object is visible that night by using astronomy software like Stellarium (See Activity 1) or by doing some calculations:

**Does the object have a declination of +30 degrees (North) or lower?** If not, it is very likely that it is not observable. If yes, continue with the next question.
Is the object at least 4 hours, or 60 degrees away from the Sun in the sky? You can figure this out by first roughly calculating the right ascension (R.A.) of the Sun today:

<table>
<thead>
<tr>
<th>Month</th>
<th>Jan</th>
<th>Feb</th>
<th>Mar</th>
<th>Apr</th>
<th>May</th>
<th>Jun</th>
<th>Jul</th>
<th>Aug</th>
<th>Sep</th>
<th>Oct</th>
<th>Nov</th>
<th>Dec</th>
</tr>
</thead>
<tbody>
<tr>
<td>R.A.</td>
<td>20</td>
<td>22</td>
<td>0</td>
<td>2</td>
<td>4</td>
<td>6</td>
<td>8</td>
<td>10</td>
<td>12</td>
<td>14</td>
<td>16</td>
<td>18</td>
</tr>
</tbody>
</table>

The R.A.s in the chart above are for the middle of each month, so if you are at the beginning of a month, subtract one hour from the R.A., and if you are at the end of the month, add one hour to the R.A.

Compare your object’s R.A. with the Sun’s R.A. Is there at least 4 hours difference? If not, your object is not observable. If there is 4 hours difference, then your object is observable! Congrats!

Here is a chart of some objects in the night sky and their coordinates. Fill in the last column with a yes or a no depending on whether or not the object is visible to the PROMPT telescopes tonight.

<table>
<thead>
<tr>
<th>Object Name</th>
<th>RA</th>
<th>Dec</th>
<th>Observable from Chile?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sombrero Galaxy</td>
<td>12:39:59.4</td>
<td>-11:37:22.9</td>
<td></td>
</tr>
<tr>
<td>Polaris (North Star)</td>
<td>02:31:49.1</td>
<td>89:15:50.7</td>
<td></td>
</tr>
<tr>
<td>Tarantula Nebula</td>
<td>05:38:38</td>
<td>-69:05:42</td>
<td></td>
</tr>
</tbody>
</table>

If some of the objects are not currently visible, are they visible at any other time during the year? If so, in which months are they visible?

b. Choosing targets within the solar system

This part of the activity will allow you to determine the coordinates and visibility of objects located within our solar system. In these projects you will mainly be concerned with major and minor planets. While you are probably very familiar with the nine major planets in our solar system, you may not have known that there are many other large rocks out in space. Since these rocks are not as big as the major planets, astronomers call them minor planets or asteroids. In particular, we will use a website called *Heavens Above* to determine the coordinates of these major and minor planets. We can also use the website to determine which minor planets are currently visible from Earth.

**Major Planets:**

From the first step in your project, you should already know which major planets are currently visible from the earth. Now you must determine their coordinates. Open up an internet browser and in the address bar type: www.heavens-above.com. Now click the blue link for “log-on”. Login to heavens-above using the following username and password:
User-Name: OBSERVE-NC
Password: astrorocks

Note: There are no spaces in the username or password.

After logging in, look under the Astronomy section for link titled “Planet Summary data.” Click the link and you should see a table of all of the major planets. Use this table to find the coordinates of your planet.

Now try re-loading the page. Did anything change? You should have noticed that the coordinates changed! Remember, objects in your solar system orbit around the sun. As they move around they sun they appear to wander around on the celestial sphere. This means that their coordinates will change! Planets close to the sun move very fast and for this reason, you will see their coordinates change much more quickly than those planets further out from the sun. You should use the current coordinates of the planet and hopefully it won’t move too far before the telescopes are able to carry out your observation.

Minor Planets:

With minor planets, we must first think about what makes some targets good and other targets bad. The most important requirement for picking your target is its visibility. Since all of the planets and asteroids are moving around the Sun at different speeds, the time at which they rise and set will change as days, months, and years go by. This means that during some parts of the year, some of the planets will rise early in the morning and set just before sunset. It is not possible to observe these minor planets because they are only up in the sky during the daytime. Other minor planets may rise even earlier in the morning and then set even earlier before sunset. These planets would only be visible for the couple of hours they are up before sunrise. The perfect minor planet would be one that rises just as the Sun sets and then sets just as the Sun rises. This minor planet would be up in the sky for the entire night. The list below was taken from the website that you will be using shortly.
The names of the brightest known minor planets in the solar system are listed in blue. To best understand how to determine each of the minor planet's visibility, let us run through an example: Suppose that we want to observe 4 Vesta, the first minor planet in the list. By clicking on its name, a new page opens. At the top left of this page there is a diagram which is shown below.

The yellow spot in the middle represents the Sun, the blue circle with the “E” is the Earth, and the red circle with the “M” represents Mars. The black circle with the 4 shows where the minor planet is currently located. To determine whether Vesta is a good or bad target, simply go through the following steps:
Draw a dashed line from the Sun to the Earth and extend this line out to the edge of the image above. Draw a line through Earth perpendicular to the line drawn in step 1. Find the side of the line drawn in step 2 that does not contain the Sun and lightly shade it in.

Your image should look similar to the one below.

1. [Diagram showing a dashed line from the Sun to the Earth and a line through Earth perpendicular to it.]
2. [Diagram showing the lightly shaded side of the line drawn in step 2.]
3. [Diagram showing shaded region and red line.]

Targets that lie in the lightly shaded region will be visible for a decent amount of time during the night. Therefore, since Vesta does not lie in this region, it would not be a good target to choose.

Targets that lie in the shaded region, but very close to the red line would be up for only part of the night. While it is acceptable to choose these targets, they are still not the best.

The absolute best targets will not only be in the shaded region, but they will also lie near the black line that was drawn in step 1.

Here are two more diagrams for two other minor planets. Astrea is on the left and Massalia is on the right. Try running through the steps above to determine whether these planets are good or bad targets. Write a G under the good targets and B under the bad targets. If both are good, then circle which would be the better target to choose. You should have written a G beneath both.
minor planets, but since Massala is closer to the black line, you should have circled it because it is the better target to choose.

It is important to remember that at the top of these images it shows a date: 23 Aug 2005. Since this is not today's date, these images are no longer useful. You must now go online and analyze all of the new diagrams for the minor planets.

Heavens Above Website

- Open your internet browser and in the address bar type: www.heavens-above.com
- Down the page on the left side you will see another link called log-on. Click log-on.
- User-Name: OBSERVE-NC
- Password: astrorocks
- You should now see Heavens-Above Main Page at the top of page.
- Scroll down until you see a link called Minor Planets under the Astronomy Section and click on it.
- You now should see the list of Minor Planets. Click on the name of the first Minor Planet in the list.
- At the top left of this page you will see the familiar diagram with the Earth, Sun, Mars, and the minor planet you chose. If you do not, then click the back button on your internet browser and choose the next minor planet in the list.
- If you do see the diagram, analyze it using the steps listed above to determine whether this minor planet is a good or bad target.
- If it is visible from the Earth, then write its name down on a piece of paper and remember to write down its coordinates as well (the RA and the Dec).

Following the procedure above only ensured that the target would be up in the night sky for most of the night. We must now check that the target will be observable from the southern skies in Chile, South America.

To check this, examine the coordinates of your object by asking yourself the following question:

Does the object have a declination of +30 degrees (North) or lower? If not, it is very likely that the object is not observable. If yes, then you know that the object is a good target to use if you wanted to observe a minor planet/asteroid.
C. Telescopes: Tools of Astronomers

When most people think of astronomy, telescopes immediately come to mind. Modern astronomy would be impossible without the invention of the telescope. About 400 years ago, Galileo was the first astronomer to point his telescope toward the heavens above. He discovered four star-like objects near Jupiter, and, by keeping notes of his observations over time, he found that these objects were actually moons of Jupiter. This truly revolutionized the field of astronomy.

Figure 3.1 (Courtesy: NASA)

Many things have changed in astronomy since Galileo’s time. Telescopes that astronomers use are no longer long tubes that can be held up to one’s eye (Figure 3.1). Instead, astronomers use telescopes so large that they fill entire buildings! Why do astronomers need such large telescopes and how does a telescope work?

To answer these questions, the best place to begin is with the eye. Eyes work by collecting light. You may have noticed that some animals have quite large eyes and other animals have small eyes. Why might there be such a difference in eye size among different animals? Most animals with large eyes are nocturnal, which means that they usually sleep during the day and are most active during the night. Large eyes collect a lot of light and, therefore, allow nocturnal animals to see very well at night; the more light you can collect, the better you see really faint/dark things. For example, imagine that we are walking through a barn late one night. While we might see what is shown on the left, a nocturnal creature, such as an owl, might see what is shown on the right.

Figure 3.2 (Courtesy: NASA)

We would see the mouse as being very faint/hard to see, but it would appear bright and easy to see to the owl. The collection of more light makes faint objects easier to see.

Project: OBSERVE 2007
If you were to go far away from the lights of cities and look up into the night sky, you would see about 4,000 stars; however, this is not all of the stars in the sky. Your eyes are only able to see the brighter stars. To see the faint stars, you would need to collect more light. This is precisely why astronomers use telescopes. In fact, with a large telescope, you can see millions of stars!

Types of Telescopes

While there are many different types of telescopes, their purpose is always the same: to collect as much light as possible. The difference between the various types of telescopes is how they manage to collect and deliver the light to your eye. Here are a couple different types of telescopes (see Figure 3.3):

![Types of Telescopes Diagram](image)

From the names above, you will notice that one of the telescopes is a reflector and the other is a refractor. A refracting telescope bends light into your eye, while a reflecting telescope uses mirrors to reflect light into your eye. While refractors are easy to use and very simple in their design, reflectors are favored because they are much larger and, therefore, can collect more light.

CCD Cameras

Not only are our eyes horribly small when it comes to collecting light, but they are also extremely inefficient when it comes to storing the light. This disadvantage led to the invention of the CCD camera.

Think of a CCD camera as a grid. Inside each square of the grid is a bucket with a lid covering the top. When an astronomer wants to take an image, s/he will remove all of the lids that cover the buckets called, “opening the shutter.” Every time energy (light) strikes a square in the grid, the bucket catches it. When the astronomer is ready, the lids are placed on the buckets and a computer reads the amount of light in each bucket. From this data, the computer constructs an image. Finally, the buckets are emptied so the camera is ready to take the next image. As long as the buckets do not fill to the top and overflow, one can leave the shutter open for a very long time, collecting a lot of light and producing images of very faint objects.

Using the bucket analogy, we can see why our eyes are horribly inefficient when it comes to storing light. Human eyes do not give the buckets time to fill up. Instead, they, very quickly,
open and close the lids to the buckets, create an image, empty the buckets, and then start all over. In fact, they complete this cycle thirty times every second!

CCD cameras are better understood with an example. If you look very carefully at a computer or television screen, you will notice that it is broken down into thousands of very tiny squares called pixels. The buckets mentioned above represent the pixels in a CCD camera’s image. Pretend that we just pointed our telescope toward a planet. When we look through the eyepiece we see the image shown below (see Figure 3.4):

![Figure 3.4](image)

Now, let’s take an image with a very small CCD camera that consists of only 9 pixels/buckets. How much light will land in each bucket? Figure 3.5 below shows the arrangement of buckets, and the numbers represent the amount of light in each bucket.

![Figure 3.5](image)

The only bucket that caught light was the center bucket; the rest of the buckets remained empty. To figure out what our image would look like, let us return to what we saw in the eye piece. We need to divide the image into nine equal parts (one for each pixel).
It makes sense that the planet appears only in region 5 because region 5 represents the center bucket from above. So now let’s see what our image would look like (Figure 3.7):

Why doesn’t our image look exactly like what we saw through the telescope’s eyepiece? With only nine pixels, our camera cannot see very much detail. Let’s repeat the process again, but this time we will use thousands of buckets/pixels. The image that would result is shown below (Figure 3.8):

You can still see the tiny squares around the edge of the planet, but at least now our image looks a lot more like what we saw through the eyepiece. The more pixels you use the more detail you will have in your image.

Filters
It turns out that a wealth of astronomical information can be gained not through black and white images (like those taken by CCD cameras), but through color images. How can we determine the amount of each color of light in the buckets? There is a simple solution to this problem. We should allow only a certain color of light to enter the camera, filtering out all other colors. Then we will know that the light is the same color in all of the buckets. To accomplish this, special pieces of glass are made to only allow certain colors to pass through. Called **filters**, astronomers place these pieces of glass directly in front of the CCD camera. The light from a celestial object passes through the filter before entering the CCD camera. A **filter wheel** is a device that holds multiple filters and allows one filter at a time to be in front of the camera. When astronomers want to switch from one type of filter to another, they simply rotate the wheel.

For example, pretend you want to take an image of a star and measure how red it is. One way to accomplish this is to rotate your filter wheel so that the red filter is positioned in front of the camera. You could then point your telescope to the star and take an image. The image the computer gives you will still be black and white, but since you know that only red light landed in the buckets you simply measure the brightness of the star in your image. Whatever brightness you calculate is a measure of how red the star is.

**Types of Filters**

It is important to remember that visible light is not the only type of light. We are very familiar with visible light because it is the only type of light that is visible to our eyes. Figure 3.9 shows all of the different types of light:

![The Electromagnetic Spectrum](image)

Figure 3.9 (Courtesy: NASA and the Hershel Space Observatory)

While this may sound quite bizarre, the radio waves, that are detected by your car’s antenna and converted into your favorite type of music, are a form of light! Not only are radio waves a form
of light, but so are the waves that interact with your food in a microwave oven; however, when you are riding in your car you see nothing going into the antenna, and when you look into the microwave it appears to be magic alone that makes your food begin to sizzle. You can only see visible light, not radio, microwave, or any of the other types of light because our eyes are sensitive to only to visible wavelengths.

The type of light is determined by the wavelength of the light. The wavelength of a wave is measured from crest to crest, or trough to trough (see figure 3.10).

Figure 3.10

Visible light is the range of wavelengths from 400 nm to 700 nm (where nm stands for nanometer). This means that the distance between two consecutive troughs or crests in the wave is about 1/6000 the width of a human hair!

Radio waves have a very long wavelength, so you can think of them as waves that have been stretched out. Gamma rays have a very short wavelength, and they appear to be smashed tightly together (see Figure 3.9).

Why should we worry about these other forms of light, if we cannot ever see them?

While our eyes are not sensitive to all wavelengths, we are able to design cameras that are. For example, the police use infrared cameras when they are searching for a criminal at night. Figure 3.11 shows an image of a dog taken with an infrared camera.
Had this been taken with a regular camera, one might want to return the camera; however, an infrared camera’s image is not supposed to look like a regular camera’s image. Try to determine how an infrared camera works by analyzing the image above. The nose and fur of the dog are both colored purple, while the eyes and mouth are red. Here’s a hint: what part of a dog’s face is usually the coldest? It’s nose! It turns out that an infrared camera is really taking a picture of differences in temperature.

Hot objects emit a lot of infrared light. It does not matter whether it is day or night. As long as the temperature of the object does not change, it will emit the same amount of infrared light.

Since cameras can detect light that even our own eyes cannot see, filters must be made for not only the visible light but for other types of light as well. Ground-based telescopes are only able to observe short wavelength infrared wavelengths, visible wavelengths, and long ultraviolet wavelengths. Since we are using ground-based telescopes, we will only use filters that cover ranges of wavelengths within these types of light (see Table 3.1).

<table>
<thead>
<tr>
<th>Name</th>
<th>Type of Light</th>
<th>Wavelength Range (nm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>U</td>
<td>Ultraviolet</td>
<td>320 to 400</td>
</tr>
<tr>
<td>B</td>
<td>Blue</td>
<td>400 to 500</td>
</tr>
<tr>
<td>V</td>
<td>Green</td>
<td>500 to 700</td>
</tr>
<tr>
<td>R</td>
<td>Red</td>
<td>550 to 800</td>
</tr>
<tr>
<td>I</td>
<td>Very Red</td>
<td>700 to 900</td>
</tr>
<tr>
<td>H-Alpha</td>
<td>Red</td>
<td>650 to 660</td>
</tr>
</tbody>
</table>

Table 3.1

There is also another type of filter called a **Neutral Density filter**. This filter affects the brightness of an object in all colors. Simply put, it allows you to take images of very bright objects that would otherwise very quickly fill up your camera’s buckets/pixels.

Figure 3.11 (Courtesy: NASA)
Uses of Filters

Astronomers use filters for countless reasons. Determining the intensity of light emitted or reflected by a celestial object across different wavelengths can provide important information about the object, such as color, temperature, and chemical composition. For our purposes, there will be two primary reasons to use filters:

1) Making a color image
To make a color image, astronomers must take three separate images: one using a blue filter, one using a green filter, and one using a red filter. Upon receiving the images from the computer they will each be black and white. Astronomers then use computer software to color the three images blue, red, and green respectively. Merging the three images into one image will result in a color image of the celestial object.

2) Distinguishing features
Imagine a pretend galaxy with three stars in it. One star is producing lots of ultraviolet light. If you take an image of the galaxy with no filter, you may not be able to tell one star from the other – they might all have about the same brightness. However, if you take an image of the galaxy with a U filter that only allows long wavelength ultraviolet light through, the star producing lots of UV light will clearly stand out from the other two stars.

As you will find in Activity 3 – Filter Fun, filters are very important tools of astronomers.
Activity 3: Filter Fun

Objectives:
Explore how telescope filters work
Learn the uses of filters in astronomy

Materials Needed:
Class set of Red/Blue 3D glasses

Class set of sunglasses

1 100-watt lamp (no shade)

1 sheet of black posterboard

Piece of red construction paper

Piece of blue construction paper

Image of galaxy with red and blue stars on black background

Black and white image of same galaxy

Instructions:

1. Ask the class to look around and try to notice everything in the room that is the color red. Now ask them: "What if you could ONLY see the color red? What would the world look like?" Everything that was a color besides red would be dark. This is how a telescope with a CCD camera sees the Universe when we use a red filter: it takes an image of a celestial object but only receives the red light from the object. Astronomers use many different kinds of filters. What are they good for?

2. Glue the red and blue squares of paper side by side on the black poster board. Set up the black poster board and tell the students to look at it and describe what they see. It should be simple: a piece of blue paper and a piece of red paper. Pass out 3D glasses and tell students to look at the poster. They should see both squares. Now tell them to close one eye, then switch and do the other. What happens? One square stands out each time. When you only look through the blue lens, you see the blue square and the red square is very darkened – almost blending into the black poster board, and vice versa. This is similar to how an astronomer switches filters on a telescope to see different views of the same object.

3. Now open the image, or draw a recreation, of the imaginary spiral galaxy. The red stars represent older stars, and the blue stars represent younger stars. In real galaxies, the younger stars heat up the gas around them and makes it glow, producing a signature color. With a special filter, we can allow only that signature color into our telescope.

Project: OBSERVE 2007
That makes it obvious where the star formation regions of the galaxy lie. Star formation occurs in the spiral arms of a galaxy, so there is a higher concentration of young stars in the spiral arms. This may look blatantly obvious to the students – clearly, the blue stars are making up the arms; however, show them what the telescope sees – a black and white image of the galaxy. All the stars look the same! How do we know what color the stars really are, and which stars are younger or older? Now we put on our 3D glasses, representing the blue and red telescope filters, and examine the color image of the galaxy. Close one eye, and the red stars jump out in the center of the galaxy. Close the other eye and the blue stars jump out from the spiral arms. This is how a telescope can distinguish between different colors from a black and white image. It must use filters!

4. One type of filter is called a neutral density filter. It is used to take images of extremely bright objects like the Moon and Jupiter. Turn on the bright lamp. Students will probably not want to look directly at it, since it is so bright. Ask the students to describe what they see when they look at the light. They probably will have to squint and they will see a big glare around it. Ask them why they are squinting – to let less light in? Help them out, with sunglasses. Sunglasses and neutral density filters on telescopes both block light across the spectrum. Now students should be able to see more detail on the light bulb, just like we can see more detail on a bright object like the Moon or Jupiter when we use a neutral density filter (you might try drawing something on the bulb – test this out to see if you can see the drawing when the light is on, with and without sunglasses).
II. Student Projects
Activity 4: Observation Proposal

<table>
<thead>
<tr>
<th>Name</th>
<th>Date</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Object Name</th>
<th>Object Type</th>
<th>Object Coordinates</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>R.A.:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Dec:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>R.A.:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Dec:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>R.A.:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Dec:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>R.A.:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Dec:</td>
</tr>
</tbody>
</table>

Filters (circle) | # Exposures | Exposure Time (seconds) |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Blue</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Green</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Red</td>
<td></td>
<td></td>
</tr>
<tr>
<td>U</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>V</td>
<td></td>
<td></td>
</tr>
<tr>
<td>R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>I</td>
<td></td>
<td></td>
</tr>
<tr>
<td>H-Alpha</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Neutral Density</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Observations will be repeated __ times every ___(days/hours/minutes/seconds/)  
*Fill out only if you are making time sequence observations*

Describe the goal of these observations:
Activity 5: Submitting an observation via SKYNET

SKYNET – http://fungrb.physics.unc.edu - is a web-based observation system that controls the PROMPT telescopes in Chile. Observers can access SKYNET and enter observations at any time - day or night. It allows you to observe a celestial object (such as a planet, galaxy, or star cluster), and to choose the filters, the number of images to take, and exposure times. After you submit your observation request via SKYNET, PROMPT will complete the observations as soon as possible waiting until the celestial object is high enough in the sky.

1. Go to http://fungrb.physics.unc.edu

2. Type in your teacher’s username and password and click Login.

3. Click on SKYNET Now to see which telescopes are operational. Occasionally, telescopes will be under repair and will not be available to take images. You can find the telescope’s status under the Connection column.

4. On the SKYNET Now screen, click on a telescope’s name to see the filters available for each telescope.
5. Click on **Observation Manager**. This will bring up a list of previous observations and will allow you to submit new observations.

6. Click **Add Observation** on the **Observation Manager** screen. This will bring up the **New Observation** screen.
7. Fill in the **Observation Name** box to provide a title for your observation request. Name your request something that you will recognize easily among a list of your classmates' observation requests. You should include your name or initials.

8. If your celestial object is one that is fixed on the sky, such as a galaxy, nebula, or star cluster, you can search for its coordinates by typing its name into the **Lookup** box. Click **Lookup** and your object’s coordinates will automatically enter into the R.A. and Dec. forms. If your object is not fixed, such as a planet or asteroid, you will need to lookup its coordinates from another source, such as Stellarium or Heavens-Above.com, and enter the coordinates manually.

9. Choose the filters that you would like to use.

10. Leave all other options in the default settings and click **Choose Telescopes**.

11. Choose which telescope you would like to use (make sure the one you select is operational, as described in step 3). Click **Add Exposures**.

12. On the **Add Exposures** screen, fill in the boxes with the number of exposures you want with each filter, as well as the duration of each exposure in seconds. A bright planet, such as Jupiter or Saturn, should be imaged with an exposure time of less than one second. A galaxy or nebula should be imaged with the maximum exposure time of 80 seconds.

   **Here are some examples of appropriate exposure times:**

   Mars: 0.1 - 0.5 seconds (depending on brightness)
   Jupiter: 0.01 seconds
   Saturn: 0.2 seconds
   Uranus: 20 seconds
   Neptune: 80 seconds
   Pluto: 80 seconds
   Minor planets / Asteroids: 80 seconds
   Deep sky objects: 80 seconds

13. If you are running a time sequenced observation, to view an object that moves or changes in brightness, select the number of repetitions for your observations and the time in between each observation.

14. Click the **Post Exposures** button to advance to the observation confirmation screen.

15. Click the **Confirm** button to submit your observation.
Activity 6: Downloading your images from SKYNET

Before you can begin to work with your images, you must download and store them on your computer. To accomplish this, follow the steps below:

1. Go to http://fungrb.physics.unc.edu

2. Type in your teacher’s username and password and click Login.

3. Click on Observation Manager, which will open a list of previous observations:

4. Search for your observations by typing your teacher’s username in the search box and pressing Return/Enter on your keyboard.

5. A list of observations taken with your teacher’s username, including your observation, will appear. Now find your observation from among your classmates’. Remember what you named your observation!

6. In the status column, check the status of your observation:

   **Complete:** Your images are ready for viewing! Click on your observation’s name in the Name column to advance to the observation download screen.

   **Active:** Your images have not yet been taken. It may still be daytime in Chile. If the status of your observation is still active after two full nights of observing, it is most likely not going to work. The object may not have risen high enough in the Chilean night sky (either it is too close to the Sun,
or the declination is too far North). Check the coordinates of your object and make sure it is up in the current Chilean night sky.

Canceled: Either you or an administrator has cancelled your observation. Likely causes include:
- Selecting an exposure time that is too long for a bright object
- Attempting to use a telescope that is inoperable
- Submitting too many exposures that will take up too much telescope time

If your observation has been cancelled, try to figure out why it may have been cancelled. Correct the problem and resubmit the observation.

In Progress: Some, but not all, of your images have been taken. You can download the images that are finished.

7. If your observation is complete, click on your observation’s name to advance to the image download screen:

8. To quickly view your images, click on the (JPEG) link. This will bring up the images in your web browser.

9. To download your images for editing, click on the Archived (FITS) link. When the web browser prompts you to open or save the file, click Save. A window will open prompting you to save your images in a specific folder. Your teacher should tell you an appropriate location to save your images. Inside of that folder, make a new folder named Project: OBSERVE 2007
---OBSERVE (with --- replaced by your initials). Inside of ---OBSERVE, make a new folder called data and save your images in that folder.

10. If you are downloading calibration files (needed if you plan to complete advanced image reduction in Activity 8 – Advanced Imaging Tools), find them by searching for calibration in the observation manager search box. Depending on the thoroughness of your image reduction, you may want to download just one of each type of image: dark, bias, and flat, or up to 20 of each. Make new folders called flat, dark, and bias inside of the data folder.
Activity 7: Reading Your Images

The most important steps in completing your projects will be opening, viewing, analyzing, and, finally, exporting the images so that you may use them in posters, papers, presentations, or any other form of presenting your results.

The first question you must ask yourself is whether you want to open a single image or a whole series of images because the procedure for each is different. If you are opening a sequence of images, skip down until you see the heading Opening a Sequence of Images.

Opening a Single Image

Open ImageJ. The following window should appear:

Now open the image. To do this click on File and then move our mouse down to Open. A file browser window should then appear:

Click on the image you would like to open and then click the Open button. The following window should appear:
You have successfully opened your image.
Skip down to the section on **Brightness and Contrast**

**Opening a Sequence of Images**

Open **ImageJ** by double clicking the ImageJ icon on the desktop. The following window should appear:

Now open the images. To do this click on **File** and then move the mouse down to **Import**. Import options will appear to the right. Click **Image Sequence** and a file browser window should appear:

Click the first image in the sequence and then click **Open**. A new window will open titled **Sequence Options**. In the box beside **Number of Images**, ImageJ should have automatically entered the total number of bias images in the folder, in this case, 20 images. There is no need to change any of these settings. Simply click the **OK** button and another window should open.
This large window is called a **stack** because it holds all of your bias images, almost as if they were in a physical stack. Let’s look at the parts of the image highlighted in red. The red image at the top, noted with a 1 is the **information bar**. Here is an explanation of what you can learn from the information bar:

1/20
Tell you which image you are currently looking at and the total number of images in the stack. In this case, you are looking at the first image out of 20.

**DARK_Prompt5_05_09_06_3170_001.fits**
Is the name of the current image

**1024 x 1024 pixels**
Is the size of the image. Note the word ‘pixels,’ the smallest element in an image.

**16-bit Grayscale**
This is a technical term describing the way the image was saved.

**40 MB**
This is the amount of memory the image takes up on the hard-drive.

Now look at 2, the the bottom part highlighted in red. This is the **slider bar** and it allows you to scroll through all of your images.

**Brightness and Contrast**
Before we make any adjustments, you may wonder why your image is completely black. The reason for this is the brightness and contrast of the image. To change fix this, click Image>Adjust>Brightness/Contrast.

Now click the Auto button in the new window. Your image stack should no longer be black. If it is, continue on to the next section to learn how to manually adjust the brightness and contrast.

Manual Adjustment

Occasionally, you will still not be able to see anything in the image after using the auto brightness and contrast adjustment. This will usually occur if you previously aligned your image
leaving a black region around the edge. If this is the case, you will need to manually adjust the brightness and contrast until you can see your image.

Here is an example of an image that was not improved after using the auto brightness and contrast adjuster:

Take a look at the box located at the top of the Brightness and Contrast window. This plot is called a histogram. It consists of two parts: the histogram line (labeled a.) and the histogram spikes (labeled b.). While this plot only has two histogram spikes, your plot may have many more.

Adjust the Minimum, Maximum, Brightness, and Contrast and observe how each affects the histogram line.

The goal:

1. Move the bottom of the histogram line (c.) so that it is just to the left of the histogram spikes.
2. Move the top of the histogram line (d.) so that it is just to the right of the histogram spikes.

Once you have accomplished this, you should be able to see the celestial object in your image. Now you can adjust the slider bars to perfect the brightness and contrast.

Here is the image and the histogram that resulted after we followed the steps above:

The histogram has been blown up so that you can easily see the tall histogram spike (gray) and the histogram line (black). Notice how the top of the histogram line is to the right of the histogram spike and the bottom is just barely to the left.

You have now successfully opened your image!

**Exporting Images**

Make sure that the image you would like to export is visible in the ImageJ window. Then click **File>Save As>Jpeg**: 
A **Jpeg** is a type of image that can be used in nearly all programs. Saving your images as Jpegs allows you to insert your images into posters, presentations, or documents.
Activity 8: Advanced Astronomical Tools

The purpose of this activity is to demonstrate the many different tools that are available through the ImageJ software. Obtaining these skills will be essential in completing your project and you will refer back to this section many times.

Here is a list of the tools that are covered in Activity 8 as well as the projects that require their use:

- **Aligning Images**
  - Jupiter’s Moons
  - Planet Hunt
  - Planetary Motion
  - Advanced Image Lab
  - Quick Color Image

- **Combining Images**
  - Advanced Image Lab

- **Creating Color Images**
  - Advanced Image Lab
  - Quick Color Image

- **Movie Making**
  - Jupiter’s Moons

- **Image Reduction**
  - Advanced Image Lab
Aligning Images

Aligning images is necessary before combining images. Aligning overlaps all of the same features in a stack of images so that combining the images will result in an accurate representation of the celestial object.

1. In ImageJ, open a series of images (no more than 5 images).

2. Convert the images to a stack by selecting Image -> Stacks -> Convert Images to Stack

3. After the stack has been created, select Plugins -> StackReg

4. StackReg is designed to find similar features in images and align them so all of the same features overlap. Select “translation” from the StackReg drop down menu.

5. Click “OK” and StackReg will go to work. It may take as long as a few minutes to align images depending on how many images you are aligning and the speed of your computer. For example, aligning 5 images may take as long as 2 minutes.

6. Once your images are aligned, you can continue to combine them (see next section) or convert them back to images: select Image -> Stacks -> Convert Stack to Images and save the images.
Combining Images

Whenever you perform an experiment, it is always best to take multiple measurements. By averaging all of these measurements together, the resulting value is much more accurate than if you had only measured once. By applying this principle to astronomical image, you can construct a much clearer and sharper image by averaging many images together. The following steps will show you how to combine images using ImageJ.

First, you will need to open a sequence of images. For information on how to accomplish this, review Activity 7, Reading your Images. Once you have opened a sequence of images, stacking them is quite easy. Simply click **Image>Stacks>Z Project:**

A new window will open:

ImageJ should automatically enter a 1 in the blank next to **Start Slice.** The number beside **Stop Slice** should match the total number of images in your stack. Finally, the **Projection Type**
should be **Average Intensity** since we are trying to average the images together. Click **OK** to combine your images into one image.

A new window will appear with the combined image in it. You may need to adjust the Brightness and Contrast to see the image. For more information on how to do this, review the section on adjusting Brightness and Contrast in Activity 7.
Creating Color Images

Since CCD cameras only take black and white images, you may be wondering how it is possible to create a color image. Review the section on telescopes to learn about filters and how they are used to only allow light of a certain color through the camera. For example, placing a red filter in front of the camera will only allow red light to pass through. This means that the image you obtain is constructed from only red light. We can then tint the image red. Following the same procedure with two more filters, blue and green, would result in a total of three images: a red, green, and blue.

If we then combine these images in a special way we will obtain a color image! Here’s how to do this using ImageJ:

You must first open each of the three images. Do not open them as a sequence. You should have three separate windows. For help with opening images, see the previous section on reading your Images in Activity 7. Once you have opened the three images, you must first adjust the brightness and contrast so that you can see your images (see the Adjusting Brightness and Contrast Section in Activity 7). Remember, sometimes the aligning procedure causes the auto brightness-contrast feature in ImageJ to fail. In this case, use the procedure for making manual adjustments by following the instructions in Activity 7 to adjust the brightness and contrast. Make sure you can see the celestial object in all three of your images before continuing.

ImageJ can now automatically tint the three images and combine them for you. Simply click Image>Color>RGB Merge to bring up the RGB Merge window.
There will be a drop-down box beside each of the words Red, Green, and Blue. You should select the name of the image that corresponds to each of these colors. The following chart should help you decide the color of each image:

<table>
<thead>
<tr>
<th>Filter through which the image was taken</th>
<th>Corresponding Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>Blue</td>
</tr>
<tr>
<td>Blue</td>
<td>Blue</td>
</tr>
<tr>
<td>V</td>
<td>Green</td>
</tr>
<tr>
<td>Green</td>
<td>Green</td>
</tr>
<tr>
<td>R or Rc</td>
<td>Red</td>
</tr>
<tr>
<td>I or Ic</td>
<td>Red</td>
</tr>
<tr>
<td>Z</td>
<td>Red</td>
</tr>
</tbody>
</table>

To keep your original images, check the box next to Keep Source Images. You may then click OK.

A new window should appear with your color image. However, it will probably not look very good. For example, the following is the result from an attempt to make a color image of the Whirlpool Galaxy:

Notice the different colored strips along the right side and the top of the image. These strips are highlighted in red in the image to the right. The reason they are in your image is because not all areas of the images overlapped after you aligned them. You will need to remove these areas.

To remove the unwanted areas, draw a box around the part of the image you wish to keep. To draw a box, make sure the rectangle selection button is depressed on ImageJ’s main tool bar (highlighted in red below):
Once the **rectangle selection button** is selected, you can simply click and drag your mouse across your image. You should see a yellow box appear. Make sure that the part of the image you want to keep is inside your box. To remove what is outside, click **Image>Crop**:

Now that you have removed the bad parts of your images, we can work on making it look nice. This can be done by adjusting the color. Close the **Brightness and Contrast window**. Now click **Image>Adjust>Color Balance** to bring up the color adjustment tool.
This is the trial and error part of making color images. You will recognize the three sliding bars Minimum, Maximum, and Brightness from the Brightness and Contrast window. In addition to these bars, you will notice the drop down box. Click on the drop down box to see a list of colors. Starting with Red, adjust the Minimum, Maximum, and Brightness slider bars to change the amount of red in your image. After you are satisfied with the red, be sure to click Apply. If you don’t click Apply, your changes will be lost as soon as you begin working on the next color. To change the color, click the drop down box and choose the next color in the list.

**Remember:** This is a trial and error process. Feel free to go back to previous colors to change them further. If you ever make a change to a color that you are not happy with, simply click the Reset button. If you make too many changes and are unhappy with your image, you can always go back to the RGB Merge step to create a new color image.

Finally, after you are satisfied with the colors, close the color window and reopen the brightness and contrast window. Adjust the brightness and contrast of your RGB image until you are satisfied with the result.

This is the result after adjusting the color balance and the brightness and contrast:
Movie Making

Before you are able to make a movie, you must have a stack of images open in ImageJ. Once you have the stack of images open, you need to check for black regions around the edge of your images. These regions are caused by the aligning procedure. Examine all of the images in your stack and find the one with the largest black border. Make sure that the rectangular section button is depressed:

Once the rectangular section button is selected, you can simply click and drag your mouse across your image. You should see a yellow box appear. Draw the box around the section of your image without the black border. To remove the border, click Image>Crop

Now look through all of your images and make sure you have removed the black border from all of your images. If you find an image that still has a black border, follow the same procedure noted above to remove it. Continue this until all images are free of a black border.

Now you can use the auto brightness and contrast adjustment feature noted in Activity 7. You should now be able to see the celestial object in all of your images.

All that is left is to click Save As > AVI:
This will bring up a browser window. Simply choose the location on your computer where you want to save the movie.

ImageJ does not have the ability to open movies. For this reason, you should minimize ImageJ. Look through the folders on your computer to find your movie. Double click the file to open and play the movie in the default movie player.

Notes: If your movie appears to have frames that are not in the correct order, you should review your image stack in ImageJ. The movie frames in the same order as the images in your stack. Your images may appear out of order in your stack if the filenames have been changed. ImageJ orders the images based on their filename. The default filename that SKYNET gives to the images should ensure that ImageJ opens them in the correct order.
Image Reduction

Background

The images that you download from SKYNET are raw, meaning that they have not been processed to remove unwanted features. Each image you download will have a signal to noise ratio. **Signal**, or light that the CCD receives from the celestial object you are observing, is good. **Noise**, or anything in your image that does not come from the celestial object, is bad. The goal of image processing is to increase the signal to noise ratio by removing unwanted features that appear in astronomical images.

The process of taking images with CCD cameras is not without error. In fact, there is a large amount of error involved in this process. It is important to remember this because all images taken with CCD cameras will have some amount of error, and it is your job, as an astronomer, to remove the errors. Let’s begin by discussing each of the three main types of error that will be present in all of your images.

In the CCD Camera section of the Telescope lesson, you may remember that we used a small 9 pixel CCD camera to take an image of a star, and we saw that only the center pixel/bucket caught light. We will refer back to this example in our discussion of the three types of calibrations.

Bias (Read-Out) Noise

Everytime you take an image, the CCD camera’s pixels begin to fill up. After finishing your exposure, the shutter closes and the pixels stop filling up. To construct your image, you need to know how much each pixel was filled. To do this the camera automatically sends the pixel information through a cable to a nearby computer. Along the way, inevitably, some of the information is scrambled. The transfer of data from the camera to the computer (read-out) introduces this type of error (noise).

Good news! We can measure this **bias noise error** and correct it in our images. We accomplish this is by taking an image with a very small expsoure time. What results is a measurement of the amount of noise/error that is introduced from the transfer of the image. Here is an an example:
With our very crude nine pixel CCD camera from above, we took an image of a planet in the center of the camera. We know that the pixel measurements should be ‘0’ in all pixels except the center pixel and ‘10’ in the center pixel. However, after taking the image, we find the values shown below:

![Image 1](image1.png)

Using this image, we might calculate the brightness of the planet as 12. However, we know, from the previous image, that the planet's brightness should be 10. Also, the border pixels are no longer 0. Why is our measurement wrong? Take a look at the bias image taken to measure the error introduced while transferring the image from the camera to the computer.

![Image 2](image2.png)

With this second measurement, removing error from the original image is quite simple. Try subtracting the pixel values in our bias image from the pixel values in our original image. Starting with the top-left pixel, the error value is -1 and the value in the original image is -1. Therefore,

\[-1 - (-1) = 0\]

Our new pixel value is 0. This is exactly what it should be! Now try the same thing with the center pixel: the error value is 2 and the value in the original image is 12. Therefore,

\[12 - 2 = 10\]
Once again, this is exactly what it should be! As it turns out, to remove bias error you simply need to subtract the bias image from all of your images. As you will soon find out, software, like ImageJ, makes it possible to do arithmetic with images.

**Dark Noise**

In the above example, we assumed that bias noise was the only source of error and, for this reason, subtracting the bias image gave us the scientifically correct image. While this assumption is perfectly okay for the sake of simple examples, it is not actually the case with real images, so we must correct other errors. Another type of error is called dark noise which is, by far, the strangest source of error.

If you remember the section on filters, you will recall the discussion about infrared cameras. You should also remember that infrared cameras really take pictures of heat!

A person's body temperature emits a type of light we call infrared radiation. While our eyes are not designed to detect this longer wavelength form of light, the use of special devices such as infrared cameras allows us to take pictures like the one above.

But what does this have to do with the error in a CCD image? The CCD camera is not like our eyes. The CCD camera collects both infrared and visible light but cannot distinguish between the two types of light. If any object nearby, including the mirrors and body of the telescope, the ground, and the camera itself, has a temperature, then it emits infrared light, which could potentially leak into the pixels and distort the image. How can we distinguish between light from the star and light from another object?

Similar to the procedure for eliminating bias noise, we need to take an image of the error. This can be accomplished by simply closing the lid on all the buckets (closing the shutter of the camera) and taking an image. If you took an image of a star with a thirty second exposure time, then you should also take another thirty second image with the shutter closed. By closing the shutter, you know that the light (heat) reaching your CCD camera comes from objects other than your star. By simply subtracting your dark image from the image of the star, you will remove the dark noise error from the image.

**Flat Fielding**

The last main source of error is quite simple to understand. Different pixels on the CCD camera have different sensitivities to light. For example, if you took an image of something that was the same brightness across the entire camera, then all of your pixels should have the same value. When you try this, you find that the values vary quite significantly. One possible reason for this is that there might be a piece of dust on your camera which blocks light from reaching one section of the camera. Once again, we need an image of the error. To obtain a flat field image, we take an image of a uniformly bright area of the sky, and see how the sensitivity of the pixels vary. If we were to run the same experiment that we did with the bias or dark noise errors, we would find that correcting this error is a little different. Instead of subtracting the flat image
from the original image, we need to divide the original image by the flat image in order to fully correct this flat field image error.

You will see exactly how this image reduction process is performed once you have obtained images for your project.

**Key Vocabulary**

**CCD**  
Charged coupled device. A CCD is a light-sensitive computer chip that converts light into electronic signals that can be read by a computer.

**Signal**  
Light that the CCD receives from the celestial object you are observing.

**Noise**  
Anything in your image that does not come from the celestial object, including infrared light entering the CCD, read-off noise, and varying sensitivity across the CCD.

**Subtract**  
You can subtract one image from another to remove unwanted features. When Image B is subtracted from Image A, each pixel value of Image B is subtracted from the corresponding pixel on Image A. What you are left with is Image (A-B). If Image B is an unwanted feature (noise), then you are left with a better image (a higher signal to noise ratio).

**Combine**  
Adding or taking the average intensity of a stack of aligned images of the same celestial object. Combining brings out faint details in the object and reduces the amount of random noise, increasing the signal to noise ratio.

**Align**  
While multiple images of the same object may look very similar, they may actually be out of alignment. If you were to stack them on top of each other, the features in the image may not align precisely. Aligning images will make sure every feature is exactly lined.

**Dark**  
An exposure with the shutter closed. This collects stray infrared light entering the CCD. You will subtract this image from your raw image to get rid of the stray light.

**Bias**  
A zero second exposure. The shutter does not open, and no light falls onto the CCD, but it still reads out to the computer. This process shows the read-out noise from the CCD. You will subtract this image from your raw image to rid of the read-out noise.

**Flat**  
An image of a uniformly lit region of the sky. They are used to measure differences in the sensitivity of the camera.
Following these steps will remove the bias, dark and flat noise/error in your images:

Creating the Master Bias

When measuring error, it is best to measure it multiple times and then average your results. This is the reason you are provided with 20 different bias frames. Here’s how to average your frames:

Open ImageJ by double clicking the ImageJ icon on the desktop. The following window should appear:

Now we need to open the bias frames. To do this click on File and then move the mouse down to Import. More import options will appear to the right. Click Image Sequence. A file browser window should then appear:

Double click on the folder called image_calibration. You should then see three folders: bias, dark, and flat. Double click on the bias folder to see the list of bias images.
Click on the first image in the sequence and then click **Open**. A **Sequence Options** window will appear. ImageJ will automatically fill the box beside **Number of Images**. In this case, there were 20 bias images. There is no need to change any of these settings in the **Sequence Options** box. Simply click on the **OK** button and another window will open.

This large window is called a stack because it holds all of your bias images, as if they were in a physical stack. Look at the parts of the image highlighted in red. The one at the top, noted with a 1, is the **information bar**. Here is an explanation of what you can learn from the information bar:

- **1/20**: Tells you which image you are currently looking at and the total number of images in the stack. In this case, you are looking at the first image out of 20.
- **DARK_Prompt5_05_09_06_3170_001.fits**: Is the name of the current image.
- **1024 x 1024 pixels**: Is the size of the image. Note the word ‘pixels,’ the smallest element in an image.
- **16-bit Grayscale**: This is a technical term describing the way the image was saved.
- **40 MB**: This is how much memory the image takes up on the hard-drive.

Now look at 2 highlighted in red at the bottom of the screen. This is called the **slider bar** and it allows you to look through all of your images. Before we do this, you may wonder why the bias
image is completely black. The reason for this is the brightness and contrast of the image. To change the brightness and contrast, click **Image>Adjust>Brightness Contrast**.

Now click the **Auto** button in the new window that appears. Your bias image stack should no longer be black.

While not that impressive, this is what a bias image is supposed to look like. Now let’s cycle through and look at all of the other bias images. Click on the **arrow** in the bottom right corner of the slider bar. Watch the information bar change as you click through each of the images.
Now we need to combine all the images into one image. By flattening the stack we improve the accuracy of the error measurement. Click `Image>Stacks>Z Project`:

ImageJ should automatically fill in a 1 for the **Start Slice** and the number of the last image for the **Stop Slice**. Make sure the **Project Type** is set to Average Intensity and then click OK. A new window should appear with a combined bias image. This new image is the **Master Bias**.
Once again, it is black because the Brightness and Contrast is not set correctly. You can follow the same steps noted above to correct the Brightness and Contrast. Now that you have the combined image, you no longer need the individual bias frames. To keep things from getting too cluttered, you can close the Bias stack by clicking the x in the upper right corner. You should now only have the Master Bias on your screen.

Creating the Master Dark

Now let's work on creating a Master Dark. The procedure is very similar to that mentioned above for the bias. We begin by importing the sequence of darks. After clicking on File>Import>Image Sequence, the file browsing window should appear. However, it will still be in the bias folder. We must change the folder to the location of the dark images: click the folder icon with the arrow in it (depicted in red below).

After clicking the folder icon, you should see the three folders: bias, dark, and flat. Now double click on the dark folder to see the list of dark images. Finally, double click on the first dark image. As before, a new window will appear titled Sequence Options. In the box beside Number of Images, ImageJ should have automatically filled in the total number of dark images in the folder. In this case, there were 20 dark images. There is no need to change any of the settings in the Sequence Options box. Simply click OK to open the stack of darks.

Project: OBSERVE 2007
If you would like to see what a dark image looks like you can adjust the brightness and contrast. However, I must warn you that, like the bias images, they are also not very exciting. Remember to look at the information bar and cycle through the images with the slider bar.

This is where the procedure differs a little from that of the bias images. If you remember from the lesson on CCD Astronomy, the bias images were a measurement of the error introduced during the transfer of the image from the camera to the computer. This means that ALL images have the bias error in them; **including the darks**. Before we combine the darks into the single **Master Dark**, we must first remove the bias error that is in them. We do this through image arithmetic!

Recalling the bucket/pixel analogy from the CCD camera lesson, each pixel/bucket counts the amount of light it captured during your exposure. If you would like to see these numbers, move your mouse over one of your dark images and look at the main ImageJ window. Beneath the buttons you will see another information bar:

![ImageJ window](image)

**X = 730, Y = 282, Z = 0**

These numbers tell you where your mouse is within the image. We will usually ignore the Z coordinate.

**Value = 1830**

This is the measurement of how much light landed in the bucket.

Or, as an astronomer would say: “There are 1830 counts in the image at (730,282).”

**What are your X and Y coordinates, and what are the counts at that location in the image?**

\[
X: _______ \quad Y: _______ \quad \text{Dark Image Counts: } \quad \text{___________}
\]

Now some of the counts are not from the dark, but are instead from the bias error involved in transferring the image. The question is, how many counts are dark? Open the **Master Bias** image you created earlier. Move your mouse to the same X and Y coordinates you noted above.

**What are the counts?**

**Master Bias Counts: _____**
Remember, the Master Bias tells us how much error is introduced due to the transfer of the image. This is exactly the number we need in order to correct the dark images. The actual error in the dark image is:

\[
\text{Dark Image Counts – Master Bias Counts} = \underline{\text{______}}
\]

Now all we have to do to correct the dark is take the counts of each pixel and subtract the corresponding pixel’s counts in the Master Bias image.

How many calculations would that be?

\[
\text{Total number of pixels in dark image} \times \text{Total number of dark images} = \text{Total number of calculations}
\]

If you remember from the first information bar, the size of the images used in this example was 1024 x 1024. This means that there are 1,048,576 pixels. Since there were twenty darks, the total number of calculations is:

\[
1,048,576 \times 20 = 20,971,520
\]

If your image size or number of darks differs from that in this example, calculate the number of calculations you would need to perform.

Number of Calculations: \underline{______}

Can you imagine how long it would take you to perform this many subtractions?

Luckily, ImageJ has the ability to perform image arithmetic. Now let's subtract the Master Bias image from all of our darks. Click **Process**->**Image Calculator**:
In the new window that appears, make sure that the stack of your dark images appears in the box beside **Image1**; the word **Subtract** appears beside **Operation:**; and the **Z projection of bias** appears next to **Image2**. Make sure that there is not a check in the boxes beside **Create New Window** and **32-bit Result**.

Click **OK** and another window will appear:

![Process Stack?](image)

Since we want to subtract the **Master Bias** from all of the dark images we click the **Yes** button.

Remember how many calculations you would have to perform to subtract the error from all the pixels? Your computer just did that many calculations in that short amount of time. Now you see why computers revolutionized astronomy!

Now let’s stack the dark images. Follow the same procedure as for the bias images: click **Image>Stacks>Z Project**. ImageJ should automatically fill in a 1 for the **Start Slice** and the number of the last image for the **Stop Slice**. Make sure the **Project Type** is set to **Average Intensity** and then click **OK**. A new window should appear with the combined image. This new image is our **Master Dark**. You may now close the original stack of darks. Now you should have two open windows; the **Master Bias** and the **Master Dark**.

### Creating the Master Flat

After clicking on **File>Import>Image Sequence**, a file browsing window should appear. However, the Look in: dropdown box will list images in the dark folder. To change the folder click the **folder icon** with the arrow in it (depicted in red below):
Now double click on the bias folder to see all the bias images. Finally, double click on the first flat image to bring up the Sequence Options window. Once again, in the box beside Number of Images, ImageJ should have automatically entered the total number of flat images in the folder. In this case, there were 20 flat images. There is no need to change any of these settings. Simply click OK to open the stack of flats.

Unlike the dark and bias images, flat images are interesting to look at. Adjust the brightness and contrast to see the image. Your image should look similar to the one below:

![Image of flat image]

The dark donut-like features are out of focus pieces of dust on the camera or filter. Notice how they prevent light from reaching the camera. The dust particles cause certain parts of the camera to be less sensitive than others. In fact, this is exactly what the flat images measure: the differences in the camera’s sensitivity.

As before with the dark images, these flat images are not perfect. Not only do they have bias noise error, but they also have dark noise error. Let’s use the Image Calculator to not only subtract the Master Bias but to also subtract the Master Dark.

Click Process>Image Calculator
First, you need to subtract the ZProjection of bias from the flat. Next, you need to subtract the Zprojection of dark from the flat. Each time you should click on the Yes in the Process Stack window.

Finally, after subtracting both errors, you can combine all of your flat images into the Master Flat. Click Image>Stacks>Z Projects to bring up the ZProjection window. Click OK on this window to combine the flat images.

Unlike the bias and dark images, one more step must be performed before the Master Flat is ready to be used; we must normalize the image. Simply put, to normalize an image means to
make the average count value of all the pixels equal to one. We can easily accomplish this by
determining the current average of all the pixels and then dividing each pixel by this value.

First, click **Edit>Selection>Select All**. This will draw a box around the entire image. Now
measure the average count value of all the pixels in this box. ImageJ can easily do this for us;
simply click **Analyze>Measure**: 

A new window should appear with various measurements in it:

Mean is another word for average. The flat image depicted at the beginning of this section has
an average value pixel value of 11,272.645.

What is the average value of in your image? __________________

Now we can use this number to normalize the image. Before dividing, there is a very important
step you must remember to follow. You may have noticed that all of the pixel counts are
integers (i.e. there was nothing to the right of the decimal place). After we divide by the average,
nearly all of the pixel values should have a decimal. For this reason, we must change the image
type by clicking **Image>Type>32-bit**:
After the image type has been changed to 32-bit, we can divide by the average by clicking **Process>Math>Divide**, and a new window should open:
We need to divide the **Master Flat** by the average value you wrote above. Type the average value in the blank beside **Value**, and click **OK**. The image will become completely black, so adjust your brightness and contrast to see the image. It should look exactly the same as before because you divided all of the pixels by the same value. However, even though the image looks the same, the pixel counts have changed. Move your mouse over the image and look at the counts in the information bar. The numbers you see should all be very close to the value one. Darker areas in the images (such as the dust rings) will be slightly less than one, and brighter areas should be slightly greater than one.

Congratulations! You have now eliminated all the errors in order to reduce your images! Always think twice before you close a window containing one of your master calibration images.

**Correcting your images**

First we need to open your images. This can be accomplished with the same procedure we used to open the calibration images. Click **File>Import> Image Sequence**:
Clicking the **up-directory folder button** twice (highlighted in red) should take you back to the folder with your images. Double click on the first image to open a new window. Once again, in the box beside **Number of Images**, ImageJ should have automatically entered the total number of images in the folder. In this case, there were 20 images. There is no need to change any of these settings. Simply click **OK** to open the stack of images.

Now let’s use the Image Calculator to correct the images. Click **Process>Image Calculator**. You will have to go through this step three times to correct each type of error: bias, dark, and flat.

Start with the bias. The correct settings for the Image Calculator window are shown below. Remember to click always **Yes** when the **Process Stack** window appears:

![Image Calculator](image1.png)

Next correct the images using your **Master Dark**. Here are the correct settings for this step:

![Image Calculator](image2.png)

Finally, correct the images using the flat.

---

Project: OBSERVE 2007
NOTE: This step is quite different from the other two. In the **Image Calculator** window, be sure to change the **Operation** dropdown: to **Divide** and to check the box beside **32-bit Result**. Make sure the settings look like those shown below:

![Image Calculator Window](image.png)

After clicking **OK** and clicking **Yes** in the **Process Stack** window, a new window should appear. The name of the new window will start with **Result of**. This new stack contains your fully reduced images. Since you no longer need your old stack, you may close that window.
Activity 9: Paper and Presentation

After astronomers complete observations and make conclusions based on their data, they present their findings to their peers. As a beginning astronomer, you will do the same!

Step 1: Write a research paper

You research paper should have five main sections:

1) Purpose – Describe the goals of this project.
2) Procedure – Give a detailed description of what you did. Be sure to provide details of your observations (exposure time, filters used, etc)
3) Data and Analysis – Explain what you got back from the telescopes. This may be as simple as a few images that you took, or it could be a table or graph of data created from your images. Include any calculations you made from the data.
4) Error Analysis – What went wrong with your project? Describe any errors that may have given you flawed images or data.
5) Conclusion – Wrap up your project, including the results of your analysis. Describe how your project met the goals stated in the “Purpose” section.

Step 2: Post your paper and images to the online OBSERVE Forum

2) Your post should include your paper and any images that you think others would find useful or interesting. This is a great place to show off your best images.

Step 3: Present to your class

1) Create a 5-minute presentation. Some effective visual aids include Microsoft PowerPoint, posters, printed images, and diagrams. Be creative!
2) Your presentation should cover everything included in your paper.
Activity 10: Posting to the OBSERVE Forum

You and every other student participating in Project: OBSERVE has access to an online forum. The forum is designed for you to communicate with your peers. You can ask questions, post cool images that you have taken, discuss the latest astronomy news, and post your research papers.

The forum website is http://observe.forumcircle.com/

There are two forums for students: “Share” and “Present”

Share

The “Share” forum is meant for, but not limited to, subjects like these:

- Astronomy news
- Night sky observations
- Discussion of projects
- Posting astronomy images (including images you have taken with Skynet)
- Communicating with OBSERVE students around the state of North Carolina

Present

The “Present” forum is meant for the posting of formal presentations and papers.

Accessing the Forum

1. Go to http://observe.forumcircle.com
2. Click the forum that you want to post in (For Students -> Share or Present).
3. You can read the forums immediately, but to post anything you will need to log in. Your teacher should have a class username and password. Click “log in” at the top right hand corner of the screen.

Posting and Replying

1. Create a new post by clicking the New Topic button.
2. If you have not already logged in to the forum, you will need to log in here.
3. Be sure to include your name in the subject line (in parentheses) after the subject because every student in your class will have the same username. For example “Question about Skynet (Your name here)”
4. To post a reply, click the Post Reply button.
Posting Images

1. To post images, you must first “host” them on the web. The OBSERVE forum cannot host images, so you must host them at another location on the web. A great site for doing this is www.imageshack.us (There are many other websites that can host images, including webshots, yahoo photos, and myspace).

2. On www.imageshack.us, follow the steps to upload an image.

3. On the next screen, it will show your image and give you a number of web addresses linking to your image. Find the Hotlink for forums (1) address and copy it (edit -> copy, or ctrl+c or apple+c).

4. Go back to the OBSEVE forum and paste that code into your forum post wherever you would like your image to appear. It will look similar to this code (the numbers in the code will be different):


5. Click on the preview button before you make your post to make sure the image appears and is in the correct place.
III. Labs
Lab: Advanced Imaging

SUMMARY

Take several exposures of a celestial object in each of the B, V, and R (or blue, green, and red) filters. Correct the images, align them, stack them, and produce a thoroughly refined color image.

BACKGROUND AND THEORY

You have seen the beautiful images of galaxies and nebulas in magazines, on the internet, and on television. Unfortunately, when you download your images from Skynet, they will not look as sharp or colorful as the images that you see published. Astronomers get back similar raw data and transform it into the magnificent images that you see.

PROCEDURE

1. Take five exposures of a celestial object in each color: B, V, and R (or blue, green, and red)
2. Download the images.
3. Download the necessary calibration files: five flats, five biases, and five darks. The dark images you download should be around the same exposure time as your images. For example, if you took 80-second exposure images, you should download 80-second exposure darks.
4. Use the following advanced imaging tools:
   - Image reduction
   -Aligning images
   -Combining images
   -Create a color image

In the end, you want to be left with three images: a fully processed blue, green, and red image. After you have them, you must align and merge them to create a fully processed color image.
Lab: Simple Color Image

SUMMARY

Create a color image from B, V, and R (or blue, green, and red) filtered images.

BACKGROUND AND THEORY

Raw images are always in black and white. Unlike our digital cameras, the CCD’s that astronomers use are not in color. They register the photons that fall onto the camera, but they do not know which color each photon is. Therefore, to make a color image, astronomers use filters that allow light of only one color at a time (blue, green, and red) to fall onto the CCD. Astronomers merge those images to form a color image.

PROCEDURE

1. Take one exposure of a celestial object in each color filter (B, V, R or blue, green, red), for a total of three images.
2. In ImageJ, open the three images.
3. Align them (see “Aligning Images” in the Advanced Tools section)
4. “RGB Merge” the images (see “Creating a Color Image” in the Advanced Tools section).
Lab: Distance to a Celestial Object

SUMMARY

Take an image of a celestial object, such as a planet, star cluster, nebula, or galaxy. Using this image and the known size of the object, determine the distance to the object.

BACKGROUND AND THEORY

Astronomers often measure the angular size of celestial objects. **Angular size** is a measurement of how much of the sky the object takes up. For example, the Moon and the Sun have about the same angular size, while they both have a much larger angular size than Jupiter. The measurement of angular size is important in determining the true size of an object, and the distance to an object. If the size of an object is known from a different experiment, then the distance can be calculated with basic trigonometry.

KEY VOCABULARY

**Light year:** The distance light travels in one year, abbreviated “ly.” Since light travels at a speed of 186,000 miles every second, one light year is equivalent to about 5.9 trillion miles. In metric units, the speed of light is $3.0 \times 10^8$ m/s, so one light year is about 9.5 trillion kilometers.

**Pixel:** The smallest working element of a CCD camera like those used by PROMPT. A pixel records the smallest distinct piece of an image. All digital images are broken up into a grid of pixels; an image size of 400 x 300, for example, means that it is 400 pixels wide and 300 pixels high. For the purposes of this project, a pixel is simply a different unit for measuring an angle, like degrees.

**Angular size:** The diameter of an object, measured as an angle rather than usual distance units. The most common unit of angular size is the degree. The sky has a total of 360 degrees, because our sky is like a sphere around the Earth (see Figure 1). All seemingly flat distances measured in the sky, or on an image taken of the sky, are actually angles.
Plate scale: The conversion factor between pixels taken with the PROMPT CCD and angular distance measured on the celestial sphere. For the PROMPT CCD cameras, the plate scale is \textbf{0.0015 degrees per pixel}.

Tangent function: A mathematical function describing the relationship between the side lengths and angles of a right triangle; the tangent of an angle is equal to the length of the side opposite the angle divided by the length of the side adjacent to it (see Figure 2).

![Figure 2](http://en.wikipedia.org/wiki/Image:Trigonometry_triangle.png)
PROCEDURE

1. Take an image of a celestial object. You may choose a planet, nebula, star cluster, or galaxy. Your object must have a known distance. Do not take an image of a star because stars have too tiny of an angular size to measure.

2. Using the Image J software, measure the diameter of the object. Use the **Straight-Line Selection** tool to measure the diameter, and then from the **Analyze** drop-down menu, choose **Measure**. The size of the diameter (in pixels) will be listed in the **Length** column of the **Results** menu that appears.

3. Convert this measurement in pixels to a measurement of angular diameter in degrees, using the plate scale given.

4. Use trigonometry to determine the distance to the object. Using the **tangent function** defined above, an equation can be set up relating the angular diameter measured, the known size of the object, and the unknown distance:

   ![Diagram of angular size and true size](image)

   \[
   \text{distance} = \frac{\text{true size}}{\tan (\text{angular size})}
   \]

ANALYSIS

Research typical distances to the type of object you imaged. How does your calculated distance compare? Is your object closer or farther away than most?

If possible, find an accepted value for the distance to your object (cite your source), and compare it to your result. Explain any discrepancy.

Research the methods astronomers use to determine distances to astronomical objects. How do you think the distance to your object was determined in the first place?
Lab: Galaxy Classification

SUMMARY

In this project, you will take images of five different galaxies and classify them as spiral, barred spiral, elliptical, or irregular.

BACKGROUND AND THEORY

Galaxies are huge collection of stars and interstellar matter. They can contain anywhere from a few million stars up to a trillion stars. Astronomers estimate that there are anywhere from 10 billion to 100 billion galaxies in the Observable Universe. No two look exactly alike; however, we can sort galaxies into four major types: spiral, barred spiral, elliptical, and irregular.

KEY VOCABULARY

Galaxy: A collection of stars and interstellar matter, containing from about 10 million to 1 trillion stars.

Observable Universe: The area of the Universe that we can see. You can imagine it as a giant sphere around the Earth, encompassing all the galaxies that we see in the Universe. Past the observable Universe, there are galaxies whose light has not had enough time to reach the Earth. The observable Universe is constantly getting larger, at the speed of light.

Spiral Galaxy: Also called “normal spiral” galaxies. These galaxies are characterized by a compact disk of stars with several arms spiraling out from the central bulge. Spiral galaxies are similar in appearance to hurricanes on Earth.

Barred Spiral Galaxy: The spiral arms in this galaxy extend not from the center, but from both ends of a central bar formed by the stars and interstellar matter in the galaxy.

Elliptical Galaxy: The stars in this galaxy are conglomerated in a shape similar to a basketball or a football. These galaxies contain mostly old stars and hardly any interstellar gas and dust.
Irregular Galaxy: Any galaxy that does not fall into the previously described categories. Often these galaxies are spiral or elliptical galaxies that have been pulled out of shape by gravitational interactions with other galaxies.

PROCEDURE

1. Take images of five different galaxies.

2. Examine the images and classify each galaxy into one of the four galaxy types: spiral, barred spiral, elliptical, or irregular. Below are examples of each galaxy type.

![](Spiral.png)  ![Barred Spiral.png]  ![Elliptical.png]  ![Irregular.png]

Spiral  Barred Spiral  Elliptical  Irregular

ANALYSIS

<table>
<thead>
<tr>
<th>Galaxy Name</th>
<th>Type</th>
</tr>
</thead>
</table>

Describe each galaxy. What features made you categorize it as you did?

Why do galaxies come in different shapes and sizes? Describe the factors that led to galaxies becoming very different in appearance.

What type of galaxy is the Milky Way, our own galaxy? If we are inside of our galaxy, how can we determine what it looks like from the outside?
Lab: Nebula Classification

SUMMARY

In this project, you will take images of five different nebulae and classify them as emission, absorption, supernova remnant, or planetary.

BACKGROUND AND THEORY

Nebulae are clouds of gas and dust in space. When the gravity of a nebula pulls together clumps of its material, stars and planets can form from the cloud. When stars reach the end of their lives, they leave behind nebulae, as either supernova remnants or large ring-shaped clouds, starting the cycle of star birth all over again.

We will classify nebulae into four categories:

- **Planetary**
- **Emission**
- **Absorption**
- **Supernova Remnant**

While each one of these falls under the category of “nebula”, they are all very different. You might say the term “nebula” is quite nebulous! **Planetary nebulae** are the result of a dying star that puffs out material around it. **Emission nebulae** result from young stars heating up the gas around them and making the gas glow. **Absorption nebulae** are mostly dust that blocks light from a background source. **Supernova remnants** are the leftover remains of an exploded star.

KEY VOCABULARY
Nebula: An interstellar cloud of gas and dust.

Procedure

1. Take images of five different nebulae.

2. Examine the images and classify each nebula into one of four nebula types: planetary, emission, absorption, and supernova remnant.

ANALYSIS

<table>
<thead>
<tr>
<th>Galaxy Name</th>
<th>Type</th>
</tr>
</thead>
</table>

Describe each nebula. What features made you categorize it as you did?

Why do nebulae come in different shapes and sizes? Describe the factors that led to nebulae becoming very different in appearance.
Lab: Star Cluster Classification

SUMMARY

In this project, you will take images of five different star clusters and classify them as either globular or open clusters.

BACKGROUND AND THEORY

Star clusters are large groups of stars that orbit a galaxy. The two main types of clusters are globular and open. These clusters are tremendously important to astronomers studying the evolution of stars, since all the stars within a cluster are believed to have formed at approximately the same time; an image of a star cluster provides a snapshot of a group of different kinds of stars all at about the same age.

KEY VOCABULARY

Star cluster: A large group of stars that is held together by gravity; all the stars in a particular cluster move at about the same speed and in the same direction.

Globular cluster: A roughly spherical group of stars located outside the plane of the galaxy. Globular clusters are made up of anywhere from several thousand to several million stars. Our own Milky Way has approximately 150 globular clusters associated with it, though larger galaxies are thought to have more.

Open cluster: A smaller group of stars found in the disk of the galaxy containing up to a few hundred individual stars. They are more loosely bound than globular clusters, and thus can be disrupted by dense molecular clouds, resulting in a stellar association, as opposed to a true cluster. A well-known open cluster is found in the Pleiades.
PROCEDURE

3. Take images of five star clusters. You can find good targets at the website: http://www.virtualcolony.com/sac/clusters.html

4. Examine the images and classify each cluster as either globular or open. Below are example images of each type.

![Open Cluster Image](image1)

![Globular Cluster Image](image2)

<table>
<thead>
<tr>
<th>Cluster Name</th>
<th>Type</th>
</tr>
</thead>
</table>

ANALYSIS

Project: OBSERVE 2007
Why do you think open clusters are usually in the disk of our galaxy, while globular clusters orbit above or below the disk?

Why is it important to see, as in a globular cluster, many different types of stars all at the same age?

We see many more globular clusters than open clusters in our sky. What is a possible reason for that disparity?
Lab: Stellar Distribution in Galaxies

SUMMARY

Take images of one spiral galaxy and one elliptical galaxy with no filter. Then take images of the same galaxies with an H-Alpha filter. Compare to find the distribution of young stars and old stars in the galaxy.

BACKGROUND AND THEORY

Galaxies are huge collections of stars and interstellar matter. They can contain anywhere from a few million stars up to a trillion stars. Astronomers estimate that there are anywhere from 10 billion to 100 billion galaxies in the Observable Universe. No two galaxies look exactly alike; however, we can sort galaxies into four major types: spiral, barred spiral, elliptical, and irregular.

Stars in a galaxy can vary drastically in age. There are young stars with ages of fewer than 10 million years, and extremely old stars that have been around for over 10 billion years. The goal of this experiment is to determine if the distribution of stars in a galaxy depends on the age of the stars. An H-Alpha filter will give us a picture of a galaxy in only a specific wavelength of light that young, hot stars produce and will show us the areas of the galaxy with young stars.

KEY VOCABULARY

Galaxy: A collection of stars and interstellar matter, containing from about 10 million to 1 trillion stars.

Observable Universe: The part of the Universe that we can see. Past this imaginary sphere, light has not had enough time to reach Earth.
Spiral Galaxy: Also called “normal spiral” galaxies. These galaxies are characterized by a compact disk of stars with several arms spiraling out from the central bulge. Spiral galaxies are similar in appearance to hurricanes on Earth.

Barred Spiral Galaxy: The spiral arms in this galaxy extend not from the center, but from both ends of a central bar formed by the stars and interstellar matter in the galaxy.

Elliptical Galaxy: The stars in this galaxy are conglomerated in a shape similar to a basketball or a football. These galaxies contain mostly old stars and hardly any interstellar gas and dust.

Irregular Galaxy: Any galaxy that does not fall into the previously described categories. Often these galaxies are spiral or elliptical galaxies that have been pulled out of shape by gravitational interactions with other galaxies.

PROCEDURE

1. Take images of two galaxies, one spiral and one elliptical. It is necessary that the spiral galaxy be “face on” (that is, the wide and flat part of the galaxy is facing Earth) rather than “edge on” because we will need to see the spiral arms clearly.

2. One image of each galaxy should be with the “V” filter, and one image of each galaxy should be with the H-Alpha filter.

ANALYSIS

Project: OBSERVE 2007
Which galaxy shows the most difference between the two different filters?

Where are the brightest regions in the H-Alpha images?

Based on your results, where do you think star formation occurs in spiral galaxies?

Why might star formation occur in a specific region of a galaxy over another?
Lab: Galilean Satellites

Project availability - project not available during grey months.

<table>
<thead>
<tr>
<th>Year</th>
<th>Jan</th>
<th>Feb</th>
<th>Mar</th>
<th>Apr</th>
<th>May</th>
<th>Jun</th>
<th>Jul</th>
<th>Aug</th>
<th>Sep</th>
<th>Oct</th>
<th>Nov</th>
<th>Dec</th>
</tr>
</thead>
<tbody>
<tr>
<td>2006</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2007</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2008</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2009</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2010</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

SUMMARY

Take several images of the planet Jupiter. Observe the visible moons and determine which moon is which by measuring how quickly

BACKGROUND AND THEORY

Jupiter has four large moons and dozens of smaller ones (as of May 2006, 63 moons have been discovered!). In 1610, Galileo discovered the four largest moons, Io, Europa, Ganymede and Callisto; these moons are known as the Galilean moons.

<table>
<thead>
<tr>
<th>Moon</th>
<th>Diameter (km)</th>
<th>Mass (kg)</th>
<th>Orbital Radius (km)</th>
<th>Orbital Period (days)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Io</td>
<td>3643</td>
<td>8.9 x 10^{22}</td>
<td>421,700</td>
<td>1.77</td>
</tr>
<tr>
<td>Europa</td>
<td>3122</td>
<td>4.8 x 10^{22}</td>
<td>671,034</td>
<td>3.55</td>
</tr>
<tr>
<td>Ganymede</td>
<td>5262</td>
<td>14.8 x 10^{22}</td>
<td>1,070,412</td>
<td>7.15</td>
</tr>
<tr>
<td>Callisto</td>
<td>4821</td>
<td>10.8 x 10^{22}</td>
<td>1,882,709</td>
<td>16.69</td>
</tr>
</tbody>
</table>

Image Courtesy NASA
**Io** is the innermost and the third largest of the four moons. It is extremely volcanically active, with sulfuric eruptions reaching 86 miles above the surface! The large amounts of sulfur make the surface very colorful.

**Europa** is a large, dense, icy moon and is the smoothest object in our Solar System. Its surface is covered with long, crisscrossing cracks possibly caused by moving water under the surface.

**Ganymede** is Jupiter’s largest moon and the largest moon in the Solar System (it’s even bigger than both Mercury and Pluto!) Its icy surface is scarred with craters and parallel fault lines.

**Callisto** is a dark, icy, low-density moon. It is covered with craters and ejecta, matter that has been ejected from volcanoes. Callisto has the largest-known impact crater in the Solar System, spreading over 600km and with rings going out almost 3000km.

**KEY VOCABULARY**

**Orbital Period:** The time it takes an object to complete one full orbit around a celestial body.

**PROCEDURE**

1. Submit observation requests to take images of Jupiter every 15 minutes for at least 3 hours. Exposure times should be .5 seconds each (higher than you would normally take of Jupiter, but you trying to image the moons, which are faint compared to Jupiter).

2. Open your images in ImageJ. Adjust the contrast minimum and maximum until you can see the moons.

3. Stack and align your images.

4. Make a movie with your stack of images. Make sure the images are in chronological order.

5. From the velocities of each moon, try to determine which moon is which (see table for orbital radii and periods)
ANALYSIS

Why do you think Jupiter has so many moons?

Is there a relationship between how long it takes a moon to orbit Jupiter and its distance from the planet?

Can you think of another way astronomers can measure the orbital period of a distant object?
Lab: Planetary Motion

Project availability - project not available during grey months.

### Mars

<table>
<thead>
<tr>
<th>Year</th>
<th>Jan</th>
<th>Feb</th>
<th>Mar</th>
<th>Apr</th>
<th>May</th>
<th>Jun</th>
<th>Jul</th>
<th>Aug</th>
<th>Sep</th>
<th>Oct</th>
<th>Nov</th>
<th>Dec</th>
</tr>
</thead>
<tbody>
<tr>
<td>2006</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2007</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2008</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2009</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2010</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Jupiter

<table>
<thead>
<tr>
<th>Year</th>
<th>Jan</th>
<th>Feb</th>
<th>Mar</th>
<th>Apr</th>
<th>May</th>
<th>Jun</th>
<th>Jul</th>
<th>Aug</th>
<th>Sep</th>
<th>Oct</th>
<th>Nov</th>
<th>Dec</th>
</tr>
</thead>
<tbody>
<tr>
<td>2006</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2007</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2008</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2009</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2010</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Saturn

<table>
<thead>
<tr>
<th>Year</th>
<th>Jan</th>
<th>Feb</th>
<th>Mar</th>
<th>Apr</th>
<th>May</th>
<th>Jun</th>
<th>Jul</th>
<th>Aug</th>
<th>Sep</th>
<th>Oct</th>
<th>Nov</th>
<th>Dec</th>
</tr>
</thead>
<tbody>
<tr>
<td>2006</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2007</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2008</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2009</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2010</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**SUMMARY**

Take images of a planet (Mars, Jupiter, or Saturn) over the course of at least few hours. Analyze the motion of the planet.

**BACKGROUND AND THEORY**

From our point of view on Earth, other planets in the solar system seem to move across the background of stars due to their motion, and the motion of Earth. Most of the time, a planet moves west to east across the background of stars, but occasionally, when the Earth “laps” another planet, that planet will move from east to west across the background of stars.
KEY VOCABULARY

**Orbital Period:** The time it takes for a planet to complete one full orbit around a celestial body.

PROCEDURE

1. Submit observation requests to take images of a planet every 15 minutes to one hour for at least 3 hours. Exposure times should be changed to reflect the brightness of the particular planet you are observing.
   - Mars: 0.4 second exposures every 15 minutes
   - Jupiter: 0.01 second exposures every 30 minutes
   - Saturn: 0.2 seconds every hour

2. Download your images from Skynet. Note the time of observation for each image. The time in between each observation, around 15 minutes, will be important in estimating the orbital period of a planet.

5. Open your images in ImageJ.

6. Stack and align your images.

7. Browse through your images. Can you see the planet moving across the background stars?

8. Measure the average angular distance that the planet moves each time period.

9. Make a movie with your stack of images. Make sure the images are in chronological order.

ANALYSIS

Which way was the planet moving: east to west, or west to east? Why is it moving in this direction?

Sometimes planets will seem to stand still against the background stars for a few weeks during the year. What would cause this stoppage of motion?

Find the angular velocity of the planet based on the CCD field of view of 1/6 of a degree by 1/6 of a degree.
Lab: Planet Hunt - The Search for Neptune and Pluto

Project availability - project not available during grey months.

### Neptune

<table>
<thead>
<tr>
<th>Year</th>
<th>Jan</th>
<th>Feb</th>
<th>Mar</th>
<th>Apr</th>
<th>May</th>
<th>Jun</th>
<th>Jul</th>
<th>Aug</th>
<th>Sep</th>
<th>Oct</th>
<th>Nov</th>
<th>Dec</th>
</tr>
</thead>
<tbody>
<tr>
<td>2006</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2007</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2008</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2009</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2010</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Pluto

<table>
<thead>
<tr>
<th>Year</th>
<th>Jan</th>
<th>Feb</th>
<th>Mar</th>
<th>Apr</th>
<th>May</th>
<th>Jun</th>
<th>Jul</th>
<th>Aug</th>
<th>Sep</th>
<th>Oct</th>
<th>Nov</th>
<th>Dec</th>
</tr>
</thead>
<tbody>
<tr>
<td>2006</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2007</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2008</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2009</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2010</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### SUMMARY

Find Neptune and Pluto against the background of stars.

### BACKGROUND AND THEORY

Neptune and Pluto are very elusive planets. They are both very dim objects in the night sky, far too faint to be seen with only the naked eye. Neptune was not discovered until 1846, and Pluto was not discovered until 1930 (both well after the invention of the telescope).

Even if you take an image of Pluto or Neptune, they will not stand out against the background stars. Only by comparing the image to an image taken in the past, when the planet was not at that location, can you pick out the planet from the stars.

### KEY VOCABULARY

- **Background stars**: In an astronomical image, the stars that are in the image in addition to your observation target.
- **Blinking**: Quickly switching back and forth between two images to reveal the differences between them.
PROCEDURE

1. Find the coordinates of the planet from www.heavens-above.com (see Activity 2 – Choosing an Observation Target)

2. Enter the observation into Skynet. Be sure to enter the maximum exposure time of 80 seconds – these planets are faint!

3. Download your image from Skynet, along with the DSS Image. On the Skynet observation download screen, you should see a link that says “View DSS Image.” Click it to bring up the image. Save the image by right-clicking on it and choosing “save image as.”

4. The DSS image is a picture of the exact same section of sky, except from a much earlier date. You can put them in a stack in ImageJ and blink them back and forth to better see the differences between the two images. By comparing your new image to the DSS image, you can pick out the star-like object that is in your image, but not in the DSS Image. That star-like object is the planet you are hunting for!

ANALYSIS

Were you able to find the planet? What does it look like in your image?

What are some other reasons astronomers might use this method of comparing a new image to an old image?

Why are Pluto and Neptune so faint?

Why weren’t we worried about Pluto and Neptune moving out of the field of view during the night we submitted the observation request.
Lab: Celestial Object Size

SUMMARY

Take an image of a celestial object, such as a planet, star cluster, nebula, or galaxy. Using this image and the known distance to the object, determine the size of the object.

BACKGROUND AND THEORY

Astronomers often measure the angular size of celestial objects. In short, angular size is a measure of how much of the sky the object takes up. For example, the Moon and the Sun have about the same angular size, while the Moon has a much larger angular size than Jupiter. The measurement of angular size is important in determining the true size of an object, and the distance to an object. If the distance to an object is known, then the size can be calculated with basic trigonometry.

KEY VOCABULARY

**Light year:** The distance light travels in one year, abbreviated “ly.” Since light travels at a speed of 186,000 miles every second, one light year is equivalent to about 5.9 trillion miles. In metric units, the speed of light is \( 3.0 \times 10^8 \) m/s, so one light year is about 9.5 trillion kilometers.

**Pixel:** The smallest working element of a CCD camera like those used by PROMPT. A pixel records the smallest distinct piece of an image. All digital images are broken up into a grid of pixels; an image size of 400 x 300, for example, means that it is 400 pixels wide and 300 pixels high. For the purposes of this project, a pixel is simply a different unit for measuring an angle, like degrees.

**Angular size:** The diameter of an object, measured as an angle rather than in usual distance units. The most common unit of angular size is the degree. The sky has a total of 360 degrees because our sky is like a sphere around the Earth (see Figure 1). All seemingly flat distances measured in the sky, or on an image taken of the sky, are actually angles.
Plate scale: The conversion factor between pixels taken with the PROMPT CCD and angular distance measured on the celestial sphere. For the PROMPT CCD cameras, the plate scale is \(0.0015\) degrees per pixel.

Tangent function: A mathematical function describing the relationship between the side lengths and angles of a right triangle; the tangent of an angle is equal to the length of the side opposite the angle divided by the length of the side adjacent to it (see Figure 2).

Figure 2: in the triangle shown, \(\tan A = a/b\) (image: Wikipedia, http://en.wikipedia.org/wiki/Image:Trigonometry_triangle.png)
PROCEDURE

1. Take an image of a celestial object. You may choose a planet, nebula, star cluster, or galaxy. Your object must have a known distance. Do not take an image of a star because stars have too tiny of an angular size to measure accurately.

2. Using the Image J software, measure the diameter of the object. Use the **Straight-Line Selection** tool to measure the diameter, and then from the **Analyze** drop-down menu, choose **Measure**. The size of the diameter (in pixels) will be listed in the **Length** column of the **Results** menu that appears.

3. Convert this measurement in pixels to a measurement of angular diameter in degrees, using the plate scale given.

4. Use trigonometry to determine the size of the object. Using the **tangent function** defined above, an equation can be set up relating the angular diameter measured, the known distance to the cluster, and the unknown size:

   \[
   \text{true size} = \tan(\text{angular size}) \times \text{distance}
   \]

ANALYSIS

Research the typical sizes of the type of object you imaged. How does your calculated size compare? Is your object larger or smaller than most?

If possible, find an accepted value for the size of your object (cite your source), and compare it to your result. Explain any discrepancy.

Are there any special features in or on your object visible in your image? Measure their size using the same method used to determine the size of the object. Describe them, and propose an explanation for what they might be.

Research the methods astronomers use to determine the sizes of astronomical objects. How do you think the size of your object might have really been determined in the first place?
Lab: Variable Stars

SUMMARY

In this project, you will take several images of a variable star and from these determine the period of variance in brightness.

BACKGROUND AND THEORY

Variable stars are given away by their name: they are stars whose brightness changes over time, often over very regular periods. The two main types of variable stars are extrinsic and intrinsic. They differ in the manner in which their brightness varies over time. The brightness variations of intrinsic variable stars are caused by physical changes in the star itself, like expansion or surface eruptions. Extrinsic variable stars, on the other hand, are caused by rotation or by eclipses by other stars.

KEY VOCABULARY

Variable star: A star or pair of stars that periodically changes in brightness or luminosity.

Period: The interval of time it takes to go through one cycle of any repeating

Intrinsic variable star: A variable star whose changes in brightness are brought about from within, usually by a radius expansion (pulsating variable) or a surface eruption (eruptive variable). One type of intrinsic variable star very useful for astronomers is the group called Cepheid variables whose intrinsic brightness has a direct relationship with its period of pulsation, allowing us to easily calculate its distance from us.

Extrinsic variable star: A variable star whose variations are caused by external factors, such as its rotation which can reveal areas with large sunspots or cause deformation of the entire star (rotating variable), or other factors such as being periodically eclipsed by another less bright companion star (eclipsing variable).

Image Courtesy NASA
PROCEDURE

1. Take at least 10 images of a variable star over the course of three nights.

2. Compare the brightness of the variable star to a normal star in your image. Use the brightness of the normal star as a constant and graph the ratio of the brightness of the variable star to the constant star over time.

ANALYSIS

Research and report about the reasons that variable stars change brightness over time.

Estimate the period of the variable star. In other words, how long does it take to complete one full cycle from bright to dim to bright again?
Design Your Own Lab

OBSERVE allows you to create your own project. Do not feel limited by the provided labs and project procedure. With the approval of your teacher, you can design and complete any project you would like to investigate. There are literally millions of things in the night sky that are waiting to be imaged, measured, and analyzed!

Here are some topics that may spark ideas:

- Tracking objects that change position in the sky
- Measuring objects that change brightness
- Analyzing properties of objects – size, color, shape, etc
- Comparing images to DSS images to find differences
Frequently Asked Questions

How long should my exposure time be?

Your exposure time will depend on the brightness of the object you are imaging. In general:

Jupiter: .01 seconds
Mars: .05 seconds to .5 seconds
Saturn: .1 seconds
Uranus: 20 seconds
Neptune: 80 seconds
Pluto: 80 seconds
Minor planets and asteroids: 80 seconds
All deep sky objects (galaxy, nebulae, star clusters, etc): 80 seconds

Where can I find celestial objects and their coordinates?

There are several places to look.

Internet

http://www.virtualcolony.com/sac/ - Another deep sky database

Books

Your teacher has a copy of Concise Catalog of 500 Deep Sky Objects. Inside you will find deep sky objects sorted by right ascension.

Software

Stellarium has many deep sky objects in its sky. Simply set Stellarium to the Chilean night sky, and find objects that are in good positions for observing (high in the sky, far away from the Sun).

Why is my image blank or very dark?

Check that the brightness and contrast have been adjusted in ImageJ. Any image, with the brightness and contrast poorly adjusted will look blank.

A cloudy sky can produce blank images. Although it is not cloudy often at the telescope site in Chile, there is an occasional overcast night.

A very bright and hazy looking image will be produced if the object is too close to the Moon at the moment of exposure. You can verify that this is the problem by looking at the Chilean night sky in Stellarium and setting the sky for the date and time that your image was taken.
Why is my observation’s status still “active” even though it’s had many nights to go through?

An observation will remain active if:
1. The object does not get high enough in the night sky (see “Choosing an Observation Target”) – you may have chosen an object that is currently too close to the Sun, or too far North on the celestial sphere to be visible from Chile.
2. You submitted a time sequence observation and SKYNET was not able to start the images because other observations were controlling the telescopes. If a time sequence observation does not get started at the requested time, it will not go through.

Why is my observation status “cancelled”?

Someone has cancelled your observation. Only administrators of SKYNET and users on your teachers’ username and password have the ability to cancel an observation. An administrator will cancel an observation if he or she determines that it may cause harm to the telescopes.

When I combine my red, green, and blue images to make a color image, it looks distorted and grainy – much worse than the original images. What is wrong?

You must properly adjust the brightness and contrast of each of the red, green, and blue images BEFORE doing the ‘RGB merge’ command. After you align the red, green, and blue images, and before you convert your stack to images, you should adjust the brightness and contrast.
Contact Information

Morehead Planetarium and Science Center OBSERVE Coordinator
Jesse Richuso – (919) 962-1237

Morehead Planetarium and Science Center Director of Educational Programs
Denise Young – (919) 843-7959

Morehead Planetarium and Science Center
UNC-CH CB# 3480
Chapel Hill, NC 27599

Standard Technical Support

Please post your technical problems in the OBSERVE web forum. Morehead Planetarium and Science Center staff will check the forum regularly and will respond as soon as possible.

Emergency Technical Support

Email or call Jesse Richuso, OBSERVE Coordinator: jesse@email.unc.edu or (919) 962-1237